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1
はじめに (Introduction)

1.1
概要 (General Overview)

Ocean Data View (ODV)は、海洋学あるいは他のジオリファレンスを与えられたプロファイル、連続またはグリッドデータを対話的に調べて可視化するコンピュータープログラムです。ODVのマルチプラットフォーム版は、Windows(9x/NT/2000/XP)、Linux、UNIXおよびMac OS Xの各オペレーションシステム上で動作します。
ODVのデータファイルおよび設定ファイルは、プラットフォーム(訳注: コンピュータの種類)に依存しません。すなわち、どのシステム上でそれらを作成しても、変換することなく他のプラットフォーム間で交換することができます。ODVは大量の測点データを対話的に閲覧できます。また、高品質な測点図(station-maps)、複数の成分間の一般的な成分間分布図(property-property plots)、選択した測点群の散布図(scatter plots)、任意の航跡に沿った成分断面図(property sections)、一般的な成分の等値面図(general iso-surfaces)を作成できます。ODVはオリジナルのスカラーおよびベクトルデータをカラードット、数値または矢印で表示します。さらに、二種類の高速なグリッド・アルゴリズム(gridding algorithms)が、断面や等値面のグリッド領域をカラー濃淡や等値線で描きます。多くの導数量(derived quantities)をオンラインで計算します。これらの変数は、ディスクに保存される基本変数と同様に表示・解析されます。
1.2
使いやすさ (Ease of Use)

ODVは柔軟性に富み、使いやすいように設計されています。ユーザーは内部のデータ記憶フォーマットの詳細を知る必要はなく、プログラミングの経験も不要です。ODVは利用可能な測点図を画面上に常に表示し、ユーザーがマウスで測点(stations)、断面(sections)、等値面(iso-surfaces)を選択して簡単にデータを操作できます。画面上のレイアウトやその他の様々な設定は簡単に修正でき、気に入った設定は後で使用できるように設定ファイルに保存できます。ODVは膨大なデータコレクションを比較的安価で広く使われているモバイル・コンピュータ上で構築管理できます。新しいデータを受け取った時にデータコレクションを拡張するのも簡単です。現場観測中あるいは研究室に戻った後での科学的なデータ解析にODVは有用です。さらに、ODVはデータの品質評価が簡単なので、教育や研修にも役立ちます。
1.3
高密度データフォーマット (Dense Data Format)

ODVのデータフォーマットは、可変長で不規則間隔なプロファイルや、連続または測点データ向けに最適化されています。膨大なデータコレクションでも高密度に保存でき、どの測点にも瞬時にアクセスできます。データフォーマットは融通がきいて、最大50個までの変数を個々のデータコレクションに保存できます。あるコレクションから別のコレクションへ変数の型と数を変えられます。ODVは個々のデータ値について品質フラグを保持していて、これらの品質フラグは、解析時に不良または疑わしい値を除くためのデータ品質フィルター(data quality filter)として利用できます。
1.4
拡張性 (Extensibility)

ODVは既存のコレクションに新規データを簡単に読み込むことができ、また、コレクションから一部または全てのデータを出力することもできます。以下に示すフォーマットの海洋学データは広く用いられていて、直接ODVシステムに組み入れることができます:
· WOCE WHP data (ScrippsのWHPOからインターネット経由で配布), 

· World Ocean Database (WOD98; WOD01; NODCからCD-ROMで配布), 

· World Ocean Atlas 1994 (WOA94; NODCからCD-ROM で配布), 

· NODC SD2 data 

· Java Ocean Atlas spreadsheet format,

· ODV spreadsheet format.

1.5
導変数 (Derived Variables)

データファイルに保存される基本的な実測変数に加え、ODVは多くの導変数(derived variables)を計算して表示することができます。これらの導変数(ポテンシャル温度、ポテンシャル密度、力学高度(いずれも基準層は任意)、中立密度、Brunt-Väisälä Frequency(ブラント─バイサラ周波数)、音速、飽和酸素など)はODVソフトウェアにコード化されているか、あるいはユーザーによるマクロファイル(macro files)またはその場(on-the-fly)で数式が定義できます。マクロ言語は簡単で、多くのアプリケーションで一般的に用いられています。新しい導数量(derived quantities)に関する数式やマクロファイルを使うことで、ODVの適用範囲が一層広がり、科学分野で未だ確立されていない新しい数量に関する実験が容易です。ODVにはマクロ・エディタが組み込まれているので、ODVマクロの作成と修正は簡単です。
どの基本変数や導変数でもODVプロットで表示でき、全て等値面（例えば等深面、等密度面、等温面またはは等塩分面; 各成分の極大または極小層、例えば中層水の塩分極小層はこれらの変数(の導数量)の鉛直微分が0の等値面として定義されます）の定義に使えます。
1.6
プロットの種類 (Plot Types)
ODVはカラーの成分断面(property sections)や三次元の等値面(iso-surfaces)上のカラー分布を、次のいずれかの方法で表示します; 方法1: (ユーザーが定義したサイズのカラードットまたは数値で)データ取得位置にオリジナルデータを表示します。方法2: (可変分解能の)矩形グリッド上にオリジナルデータを投影してからグリッド・フィールド(gridded fields)を表示します。方法1がデータの「ありのまま」の分布を瞬時に作り出し、サンプリングの乏しい領域を顕にして、不良データ値を目立たせるのに対し、方法2は見た目が良く、大きなドットサイズを使って上書きすれば方法1で起こる状態を回避できます。しなしながら、グリッド・フィールドは作られたデータであって、グリッド化処理によって(オリジナル)データに含まれるいくつかの小規模スケールの特徴を消してしまうことに注意してください。いずれの表示モードも、断面や表面のデータを専用のグリッド化，濃淡化および等値線描画ソフトウェアなどで使うためにアスキーファイルかクリップボードに出力できます(export of section or surface data)。
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全画面測点図 (Station Map) (拡大)
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選択測点の成分間プロット (Property-property plots)

(拡大)
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測線に沿った成分断面図 (Property distributions along sections)

(拡大)
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等値面上の成分分布図 (Property distributions on iso-surfaces)

(拡大)
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全測点散布図 (Scatter plots of all stations) (拡大)
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ベクトル図 (Arrow Plot) 


1.7
グラフィクス出力 (Graphics Output)

ODVグラフィクス画面(または個々のデータプロット; ただしPostScript, PNGまたはJPGのみ)のカラーまたは白黒ハードコピーは、印刷(Print)コマンド経由か、PostScriptファイル(.eps)を作成することで容易に得られます。epsファイルは、どのPostScriptプリンターでも印刷できて、ページ記述ドキュメントに含めることもできます。また、表示画面の内容を、テキストドキュメントへの包含または標準的なグラフィックスソフト(GIFと等価のPNGを使用)での後処理に適したPNGおよびJPGファイルに書き出すことができます。ODVのPNGおよびJPGの分解能は画面の解像度に依存せずに、ユーザーが設定できます。
1.8
NetCDF対応 (NetCDF Support)

ODVには、地球科学の異なる分野の研究者に広く使われているnetCDFファイルの対応機能が組み込まれています。ユーザーのわずかな指定や選択で、ODVは本来のODVコレクションをエミュレートする方法で、netCDFファイルにアクセスして解釈します。NetCDFファイルのデータを調べるために、ODVが持つ全ての解析・可視化機能が使えるので、最初にデータを変換したり書き直したりする必要はありません。NetCDFの構造と内容に応じて、別のODV「エミュレーション」が可能です。個々のエミュレーションの設定は、後の使えるようにディスクへ保存できます。NetCDFファイルはプラットフォーム(訳注: コンピュータの種類)に依存しないので、ODVがサポートする全てのプラットフォーム上で同じファイルが使えます。

1.9
ODVのモード  (ODV Modes)

ODVは五つの異なるモード、MAP(地図)、STATION(測点)、SCATTER(散布図)、SECTION(断面図)、SURFACE(表面)で操作できます。これらのモードはF8からF12キー(訳注: キーボードの上側にあるファンクションキー)を押すか、背景ポップアップメニュー(background popup menu)から適切なオプションを選ぶことで、いつでも簡単に切り替えられます。現在のモードと有効な設定ファイルは、ODVステータスバーの右端に常に表示されます。初期設定はSTATIONモード(新規データコレクションの初期モード)です。
MAP(地図)モードは全画面の測点図を描画するもので、データプロットはできません。このモードは高品質な航跡図の作成に使ってください（地図ウィンドウ(map window)のサイズと位置を定義して、五つの地図投影法から選択して、適切な海岸線および海底地形を定義し、測点番号と航海ラベルの付いた個々の測点が示されて、プリントアウトまたはPNGやJPG、EPS Postscript ファイルを生成します）。
STATION (測点)モードは(以降の全てのモードと同様に)、測点図と一つ以上(最大20)のデータプロット・ウィンドウを生成します。このモードは、選択した測点に関する(任意の基本または導変数の)X/Yプロットの作成に使用して下さい。地図中の測点上でマウスの左ボタンをクリックするか、航海ラベルと測点ラベルを指定して測点を選べます。 “p”を押すと(または測点をダブルクリックして選択・表示させると)その測点データをX/Yプロットに追加でき、Ctrl-Xを押す(訳注: Ctrlキーを押しながらxを押す)と、画面をクリアしてやり直しができます(この操作は全モードで共通です)。
SCATTER (散布図)モードでは(以降の全てのモードと同様に)、データプロットがZ変数(任意の基本および導変数)をサポートしています。あるX/Yの位置におけるZ変数の値はX/Yの位置の色を定義します。Z変数によるプロットには(SECTIONモードおよびSURFACEモードと同様に)、(1)X/Yの位置にカラードットまたは実際のデータ値を配置する方法(初期設定)と、(2)観測データを基に推定した連続的なグリッド・フィールドとして表示する方法の、二つの方法があります。グリッド・フィールドは、カラー濃淡および／または等値線で描画されます。SECTIONモードやSURFACEモードと異なり、SCATTERモードのデータプロットには(Z変数の有無に関係なく)地図に表示されている全測点の全データ点(ただし有効な測点のみ)が含まれます。
SECTION (断面)モードのデータプロットもZ変数をサポートし、SCATTERモードの全てのプロットタイプを利用できますが、プロットに使える測点セットは、通常、ある航海に沿った断面帯に制限されます。断面帯は任意で定義でき、正しく測点を選べるようにその幅を調整できます。このモードは、断面に沿った成分分布、断面内の全測点に関する成分間プロット、および断面を横切る地衝流の計算・解析に使用してください。
SURFACE (表面)モードでは、三次元空間(経度／緯度／水深)の中で、ある変数(例えば深さ、密度、水温など)が一定の値になる面を定義でき、その面上における他の変数の成分分布を表示できます。このモードでは、ある面上における任意の成分間プロットも生成できます。

1.10
Ocean Data Viewのインストール (Installing Ocean Data View)

CD-ROMまたはDVD上の実行環境(WOCE V3データリリースのDVD2のeWOCEディレクトリはそのような実行環境を含んでいます)からOcean Data Viewを動作させることができます。もしODVを定期的に使用するのであれば、お使いになるコンピュータ上にソフトウェアをインストールしたほうがよいでしょう。http://www.awi-bremerhaven.de/GEO/ODV/downloads-odvmp.htmlからWindows(9x/NT/2000/XP)、Linux、UNIX、Mac OS X 用のODVインストールファイルがダウンロードできます。

1.11
オプショナルパッケージのインストール (Installing Optional Packages)

高解像度の海岸線と海底地形ファイル、または直ぐに利用可能な(ready-to-use)データコレクションのようなオプショナルパッケージはhttp://www.awi-bremerhaven.de/GEO/ODV/downloads-odvmp.html とhttp://www.awi-bremerhaven.de/GEO/ODV/downloads-data.html からダウンロードできます。インストール方法はreadmeファイルを参照してください。

1.12
ODVの起動 (Running Ocean Data View)

一旦お使いになるコンピュータにODVがインストールされれば、ODVを起動する方法はたくさんあります。

Windows上では、インストール後にODVアイコンがデスクトップ上に置かれます。このアイコンをダブルクリックするか、スタート>プログラム>Ocean Data View (mp)の順に選んでODVを起動させることができます。また、ODVのデスクトップアイコンをウインドウズのタスクバー上にドラッグすると、タスクバーのODVアイコンをシングルクリックしてODVを始められます。ODVがサポートしているファイルを(デスクトップまたはタスクバーの)ODVアイコン上にドラッグするとODVが起動してそのファイルが開きます。ODVが起動している時は、ODVがサポートしているファイルをODVのウィンドウにドラッグするとそのファイルが開きます。ODVがサポートするファイルの種類にはODVコレクション(.var)またはODVスプレッドシート(.txt)が含まれます。

Linux, UNIXまたはMac OS Xシステム上では、それぞれのオペレーティングシステムで決められている方法でODVの実行ファイルodovmpの別名(エイリアス)またはデスクトップアイコンを作ることができます。ODVの実行ファイルはODVをインストールしたディレクトリbin_…(ここで…の部分はシステムに依存します; 例えばMac OS Xであればmacx、Linuxシステムであればlinux_i386となります)の中にあります。ターミナルウィンドウで実行ファイルの完全パスを入力してODVを始めることもできます。いくつかのシステム上では、スクリプトファイルrun_odvを使ってコマンドラインからODVを始めることができます。

初めてODVを実行すると、次のQuick Installation情報が表示されて入力を促します:

1. bin_…ディレクトリを含む完全パス名(環境変数ODVMPHOME)

2. ODV実行中に一時ファイルを書き込むディレクトリの完全パス名(環境変数ODVMTEMP)。このディレクトリには書き込み許可が必要です。システムの一時ディレクトリを使用するか、ローカルディスク上にこの目的のための特別なディレクトリ(例えば /odvmptemp)を作ることもできます。ネットワークドライブ上のディレクトリの使用は、ネットワークの転送速度が遅いのでお勧めできません。

3. 使用するコンピュータ名

4. ユーザー名またはログイン名

OKを押すとQuick Installationが完了します。それからConfigurationのGeneral Settingsダイアログを使ってODVフォントと外部プログラムの設定を変更してください。ヘルプが必要なら、F1(またはHelp>Help Topicsオプション)または多くのダイアログボックスにあるHelpボタンを押してください。

一旦ODVを起動させれば、File>Open CollectionまたはFile>Open netCDF Fileオプションを使ってデータコレクションやnetCDFファイルを開くことができます。何時ODVがデータコレクションを開いても、最後にODVを使っていたときの設定が、最初にそのコレクションに対して適用されます。また、測点選択基準も適用され、現在のデータコレクションにある測点の最初のサブセットだけが地図上に表示されます。別の測点のサブセットまたは全測点を選ぶ必要があれば、Configuration>Selection Criteriaを使ってください。

以前に保存した別の設定はConfiguration>Load Configurationを使って呼び出せます。また、Configuration>Use Templateを使って定義済みの設定の雛形から一つを選べますし、Configurationメニューまたは背景、地図、データプロットの一つの上でマウスの右ボタンをクリックしたときに現れるポップアップメニューを使って対話的に様々な設定を変更できます。Mac OS X上でマウスの右ボタンをエミュレートするにはAltキーを押しながらマウスクリックしてください。

2
ODV画面レイアウト (ODV Screen Layout)
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ODVアプリケーション・ウィンドウは以下から構成されています(画面の上から下へ)：
2.1
メインメニュー (Main Menu)
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メインメニューは以下の基本機能を提供します:
File:コレクションのオープンまたは作成; netCDFファイルのオープン; バッチモードでのODVコマンドの実行; 現在のODVグラフィクス画面の印刷; 現在のODVグラフィクス画面をPostScript，PNGまたはJPGファイルとして出力; ODVの終了。
Collection: コレクションのオープンまたは作成; netCDFファイルのオープン、コピー、名前の変更、コレクションの削除; データコレクションの並び替えと圧縮; コレクションの変数変更、現在の測点または選択されている測点のサブセットの削除。
Configuration: 測点選択基準の変更; 導変数の定義; 等値面変数の定義; 地図およびデータプロットのレイアウトの変更; 変数ラベルの変更; ODVテキストウィンドウの三行目(2.2を参照)に表示される数値フォーマットと位置; 設定の読み込みと保存、または初期設定へ戻す。
Import: 現在のコレクションへデータを読み込む(WOCEフォーマット, WOA94 CD, WOD CD, NODC SD2フォーマット, ODVスプレッドシート・フォーマット, 二種類のODVリストフォーマット)。

Export: 現在選択されている測点のデータ出力; アスキーファイルへのプロット値の出力。

Utilities: データインベントリ・テーブルの作成と時系列データ分布図の作成; 検索ボックス内の平均; 地衡流の計算と可視化; 現在のデータを基準として定義。

Help: ODVヘルプシステムの呼び出し; ODV webページへの接続; バージョンの表示。
2.2
三行テキストウィンドウ (3-Line Text Window)
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ここには現在の測点とサンプルの情報が表示されます。テキストウィンドウ上でマウスの右ボタンをクリックするとデータの編集、変数ラベルの変更、二行目と三行目に表示される数値フォーマットとその並びを変更できます。テキストウィンドウ上のある変数の上にマウスを動かすと、この変数のより詳細な情報がポップアップ・ウィンドウに表示されます。一行目の最初にある、括弧 [ と ] で区切られている範囲にマウスを動かすと、現在の測点とサンプルの選択基準の概要がわかります。
2.3
グラフィクス・キャンバス (Graphics Canvas)

グラフィクス・キャンバスはODV測点図と一つ以上のデータプロットを含んでいます。地図だけ表示されている時は、個々の測点(STATIONモード)または地図上の任意の場所(その他のモード)をダブルクリックするとデータプロットが表示されます。地図上でマウスの右ボタンをクリック(MacではAltキーを押しながらマウスをクリック)すると、データプロットまたは背景領域に別のポップアップメニューを呼び出します:
背景ポップアップメニュー (Background Popup Menu)：
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	グラフィック・キャンバスをクリアして測点図に戻ります(測点モードで描画のために選択されている測点のリストをクリアするには二回操作してください); 現在のODVグラフィクス・キャンバスの印刷; 現在のODVグラフィクス・キャンバスをPostScript, PNGまたはJPGファイルで出力; 導変数の定義; 等値面変数の定義; 地図とデータプロットの配置の変更; ODVテキストウィンドウの三行目の変数ラベル、数値フォーマットおよび位置の変更; MAP, STATION, SCATTER, SECTIONおよびSURFACEモードの切り替え; ODVの終了。


地図ポップアップメニュー (Map Popup Menu)：
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	地図の拡大; コレクションの全領域の地図を開く(Define Full Domainで定義); 標準の全球地図の作成; 測点選択基準の変更; 断面の定義(SECTIONモードのみ); 名称または内部番号による新規測点の選択; 地図表示オプションの変更(投影図法、海底地形と海岸線ファイル、測点注釈のスタイル); 現在のコレクションの領域を定義。


データプロット・ポップアップメニュー (Data Plot Popup Menu)：
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	現在のウィンドウの拡大、およびXとYの範囲設定; 現在のウィンドウのカラーバーを拡大、およびZの範囲設定; 全データ値に対して現在または全てのウィンドウのX，YおよびZの範囲の自動スケール; 現在のウィンドウのカラーマッピング変更; 現在のウィンドウのディスプレイ・オプション変更; X，YとZ変数を新たに選択


2.4
ステータス行 (Status Line)
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ステータス行にはヘルプ、状況および進行情報が表示されます。ステータスバーの右端には現在のモードと動作中の設定ファイルが表示されます。
2.5
ポップアップ・ウィンドウ (Popup Windows)

ポップアップ・ウィンドウは追加情報を表示します。ポップアップ・ウィンドウはODV画面の特定範囲(動作領域上)にマウスを置くと自動的に現れ、その範囲から離れると消えます。ODVのポップアップ・ウィンドウの概要は次の表を参照して下さい。

	ポップアップ・ウィンドウ
	動作範囲
	表示内容

	コレクション変数

(Collection variables)
	テキストウィンドウの一行目にある航海名の後にある測点フィールド
	現在有効な測点(地図の中に示される、Val)、現在のクルーズ(Cru)、および現在の測点(Sta)のコレクションの変数とデータの有効率［％］のリスト

	選択基準

(Selection criteria)
	テキストウィンドウの一行目にある［］で囲まれた範囲
	現在の測点／サンプルの選択基準のリスト

	航海情報

(Cruise information)
	テキストウィンドウの一行目の “:”の後にある航海フィールド
	現在の航海に関する情報の概要

	測点情報

(Station information)
	テキストウィンドウの一行目にある航海名の後にある測点フィールド
	現在の測点のデータ有効率

	データの概要

(Data summary)
	テキストウィンドウの二行目と三行目の最初の項目(#または“surf”)
	現在のサンプルに関する全変数のデータ値(データの品質はカラーで示される)

	データ情報

(Data information)
	テキストウィンドウの二行目および三行目のあらゆる変数
	全変数ラベル、データ値、データ品質フラグ


ODVウィンドウを最大化すると(最大化するには右上隅の最大化ボタンを押します)、ODVグラフィクス・ウィンドウは、メインまたは背景メニューの印刷コマンド、またはPostScriptファイル(背景ポップアップメニューからSave asを選択)に書き出した時に得られる全画面ハードコピーを描画します。ODVアプリケーション・ウィンドウの大きさは、右上隅のリサイズ・ボタンを押すか、ウィンドウの境界をドラッグして任意に変更できます。ODVグラフィクス・ウィンドウが小さいときは、スクロールバーを使うか、グラフィクス・キャンバスの背景領域にマウスを置いてドラッグ(マウスの左のボタンを押したままマウスを動かす)して、表示範囲を選びます。
ODVは常に現在の測点を示します。現在の測点は地図上に赤い円で示され、一般的な情報はテキストウィンドウの一行目に表示されます。新しい現在の測点を選択するには、地図上のその場所でマウスの左ボタンをクリックしてください。現在の測点におけるサンプルの一つが現在のサンプルになります。現在のサンプルのデータは、テキストウィンドウの二行目と三行目に表示され、現在のサンプルは赤い十字記号でデータプロット(存在すれば)の中で印されます。新しい現在のサンプル(および現在の測点)は、どのデータプロットの中からでも、データ点をマウスの左ボタンでクリックして選べます。
現在の測点、全測点の散布図、カラー断面図または等値面分布図を(STATION, SCATTER, SECTION, SURFACEモードのそれぞれにおいて)プロットするには、各々の測点または地図内の任意の位置をダブルクリックするか、p を押します。STATIONモードでは、他の測点をダブルクリックするだけで、その測点が追加されます。SECTIONモードでデータプロットを表示するには、最初に断面を定義する必要があります。
3
コレクションの作成 (Creating Collections)

新しいODVコレクションを作成するには、メインメニューからFile>Newの順に選択し、新たにコレクションが作成するディレクトリを選んでコレクション名を指定します。その後でコレクションに保存される変数を定義する必要があります。
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	いくつか選択できます: 変数は手動で指定するか、ODVがサポートするファイル形式(.txt, .var, .o4xまたは任意の拡張子のgeneral spreadsheetファイル)の変数、あるいは特定のプロジェクトに共通の変数セット(例えばWOCE WHP, NODC World Ocean Databaseなど)を使うこととができます。

	手動で変数を定義するか、雛形ファイルから変数を導入すると、最初の変数セットに対して追加や削除、変数ラベルの編集、変数の表示順序の変更ができます。新規に変数を追加するには、New Variableフィールドに変数ラベルを入力してAdd を押します。DeleteまたはEditを押すと変数の削除またはラベルの修正ができます。変数ラベルを編集したときには、変更を適用するにはUpdateボタンを押して下さい。あいまいな表現を避けるために、変数ラベルには常に単位を含めます(単位は括弧[...]で括ります)。
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一番目のコレクション変数は、ODVの内部でデータの並び替えに使われる特別なものです。また、コレクション変数の最大数は50個です。
下付き文字や上付き文字、特殊文字を表記するため、次の制御文字が変数ラベル内で使えます:
~$
記号フォント(ギリシャ文字)へ切り替える
~#
通常のテキスト・フォントへ切り替える

~%
パーミル記号を生成する
~^
次の文字を上付きにする
~_
次の文字を下付きにする
OKを押すと変数ラベルの定義は完了です。ODVはコレクションを作成して測点モードに切り替わり、初期設定では全球地図を描画します。初期のコレクションは空です。コレクションにデータを読み込むためには、メインメニューのImportを使用してください。
海洋データのコレクションでは、水深、水温、塩分が、最初の三つの変数としてあらかじめ定義されています。また、WOCEデータファイルとは異なり、ODVでは基本的に水深を使って変数を並び替えます。WOCEの圧力データは、読み込まれた時に水深に自動変換されます。圧力は導変数としてODVで定義できます。
3.1
コレクションファイルの概要 (Collection Files Summary)

ここではODVコレクションを構成するファイルの概要について、その役割や目的の説明と合わせて示します。通常、ユーザーがコレクションファイルの構造を知る必要はありませんが、これらの情報は問題や予期せぬ事態に遭遇したときに役立つでしょう。

コレクションデータは.var, .hob, .dobファイルに保存されます。設定ファイル.cfgはデータを含みませんが、地図領域、測点選択基準、ウィンドウのレイアウトのような、ユーザーがコレクション中のデータを眺める方法の定義に関する設定を保存します。

コレクションファイル
	拡張子
	フォーマット
	注釈

	基本ファイル
	
	必須。手動で変更してはいけません。

	<col>.var
	アスキー
	コレクション変数、保存するコレクション名、測点数を定義。このファイルはODV実行ファイルに関連付けられていて、例えばvarファイルをダブルクリックすると各コレクションとともにODVが起動します。

	<col>.hob
	バイナリ
	測点のメタデータ(名前，位置，日時など)を保存。

	<col>.dob
	バイナリ
	実際の測点データと品質フラグを保存。

	
	
	

	補助ファイル
	
	存在しなければ、ODVが自動的に作成します。

	<col>.inv
	アスキー
	航海毎に並べられたインベントリのコレクション

	<col>.cid
	バイナリ
	航海ID番号

	<col>.log
	アスキー
	ログファイルのコレクション; データ変更の記録を保管。

	<col>.idv
	アスキー
	導変数(水深、水温、酸素など)に対して入力に使用したキー変数のIDリスト

	<col>.cfl
	アスキー
	最新の設定ファイル名が含まれています。

	
	
	

	情報ファイル
	
	オプション。ODVがnetCDFデータセットをオープンしたときに作成されます。

	<col>.info
	アスキー
	コレクションまたはnetCDFデータセットの説明(書式自由のテキスト)。


上記の<col>で示されるファイル名はコレクション名から与えられます; 全てのファイルは同じディレクトリ[コレクション・ディレクトリ]に置かれなければなりません。
設定ファイル

	拡張子
	フォーマット
	注釈

	<any>.cfg
	バイナリ
	画面レイアウト、数値範囲、選択された導変数や等値面変数、その他の設定を保存した設定ファイル。設定ファイルを持つコレクション名はcfgファイルの中に記録されます。別のコレクションがそのcfgファイルを使用する場合にはいくつかの制約があります。

	<any>.sec
	アスキー
	断面の概要と特性を保存。


(上記の<any>で示される)ファイル名は任意です; これらのファイルは任意の場所に置けます。

3.2
Windows, UNIX, Mac X間の移動 (Migrating Between Windows, UNIX and Mac OS X)

ODVマルチプラットフォーム・ソフトウェアで作成されたデータコレクションと設定ファイルはプラットフォーム(訳注: コンピュータの種類)に依存しないので、修正することなくサポートされている全てのシステム上で使用できます。WindowsおよびSolaris向けのODV version 4.0またはそれ以降のバージョンで作成されたデータコレクションと設定ファイルもサポートされています。
4
データの読み込み (Importing Data)

4.1
ODVスプレッドシート・ファイル (ODV Spreadsheet Files)

ODVは様々なスプレッドシート形式のアスキーファイルからデータを読み込めます。これらのファイルのデータは、既存のデータコレクションに追加するか、新規コレクションの作成に使用できます。ODVは測点メタデータ情報やカラムのラベル情報の有無に関わらず、これらのファイルをサポートしています。カラムの分離記号にはタブ、“;”、スペース、“/”が使え、任意の指定数字または空欄は欠測として扱われます。General ODVスプレッドシート・フォーマットに関する詳細な説明は以下の表に示されています。
ODVスプレッドシート・ファイルは多くの航海における多くの測点のデータを含むことができます。ある測点における全観測層は連続した順番でなければなりませんが、必ずしも並び替えられている必要はありません。Cruise(航海名), Station(測点名), Type(観測タイプ), mon/day/yr(日付), hh:mm(時刻), Lon (°E; 東経), lat (°N; 北緯)の各項目のどれか一つでも変更があれば、ODVは新しい測点の開始であると解釈します。
General ODVスプレッドシート・ファイルを読み込む手順は次の通りです。以下で述べる、より制約のあるgeneric ODVスプレッドシート・フォーマットの読み込み手順は非常にシンプルで、ユーザーの操作はほとんど必要ありません。
General ODVスプレッドシート・ファイルから現在開いているコレクションにデータを読み込むには、Import>SpreadSheetの順で選択し、読み込みたいデータファイルの指定には標準ファイル選択ダイアログを使います。もしファイルフォーマットがgeneric ODVスプレッドシート・フォーマット(下記参照)とは異なる場合、カラム分離記号と欠測値(この値を含んでいるか空のフィールドは欠測と見なされます)を選択するためのスプレッドシート・ファイル・プロパティのダイアログ・ボックスが現れます。また、カラムのラベルを含む行(なければ空のまま)と最初のデータ行も指定できます。ODVは全項目に対して適切な初期値を与えるので、多くの場合は変更の必要がありません。Column Sep. Characterでは、 Column Labelsボックスの中にあるラベルのリストで与えられる記号を選んでください。全てのスプレッドシート・ファイル・プロパティがセットされればOKを、読み込みを中止したいときはcancelを押して下さい。
メタデータのカラム・ラベルがgeneric ODVスプレッドシート・フォーマット(下記参照)の仕様と異なる場合、コレクションのメタデータ変数に入力カラムを関連付けるための、または入力ファイルでは提供されないこれらの変数に対して初期値を設定するためのHeader Variable Associationダイアログ・ボックスが現れます。すでに関連付けされている変数にはアスタリスク(*)が付いています。新しい関連付けを定義するには、Source FileとTarget Collectionのリストの中からそれぞれ項目を選んでAssociateを押して下さい。読み込み時に変換を行うにはConvertを押して、利用可能な変換アルゴリズムを一つ選んで下さい。既存の関連付けを削除するには、それぞれの変数を選択してUndoを押して下さい。読み込むファイルがコレクション・ヘッダー変数に関する情報を一つも含んでいない場合は、次のようにして初期値を設定できます: (1)それぞれのターゲット変数を選択して; (2) Set Defaultを押して、 (3)初期値を入力してください。入力した初期値の設定はファイル内の全データ行に使用されます。実行するにはOK、読み込みを中止する時には Cancelを押して下さい。最後に読み込みオプションを指定して、OKを押すとデータの読み込みが始まります。
Generic ODVスプレッドシート・フォーマット(下記参照)と異なるファイルは、決してODVデスクトップ・アイコンまたは開いているODVウィンドウにドラッグ&ドロップしないでください。
4.1.1
General フォーマット (General Format)
	全般(General)
	アスキーコード

	ファイル拡張子(File extension)
	任意

	カラム(Columns)
	測点メタデータ情報と50個までの変数のデータ値は、分離されたカラムに保存されます。一部あるいは全てのメタデータのカラムは存在しないかもしれません。メタデータとデータのカラムの並びは任意です。ファイル中のカラムのラベルを含む行(存在した場合; 下記参照)と全データ行のカラム数は同じでなければなりません。

	カラム分離記号

(Column separation character)
	タブまたは ; またはスペースまたは /

重要: 航海および測点ラベルにはカラム分離記号を含んではいけません。例えば、カラム分離記号としてスペースまたは / を使うと、ラベル “CFC [um/kg]”は二つに分割されてしまいます。

	カラム・ラベル行

(Column labels line)
	1. 無い場合があります; あるならば、どのデータ行よりも前に置かれなければなりません。
2. メタデータとデータのカラムのラベルは任意です。推奨するヘッダー・ラベルは次の通りです: “Cruise”, “Station”, “Type”, “mon/day/yr”, “hh:mm”, “Lon (°E)”, “Lat (°N)”, “Bot. Depth [m]”.
3. データ変数のラベルは[ ]で括られる単位も含めて60文字までです。
4. 各カラムのデータ変数は、オプションとして変数の直後に品質フラグを持つことができます。品質フラグのカラムのラベルはQFあるいはQF:*のいずれかでなければなりません(*は任意の文字列)。

	データ行(Data lines)
	1. ファイルの任意の行から始まります。最初のデータ行に続く全ての行は、同様にデータ行と仮定されます(ファイルの最後にコメントはありません!)

2. 各行はメタデータと一つの観測層データを含んでいます。ある測点の全観測層は連続していなければなりませんが、並び替えられている必要はありません。一つのODVスプレッドシート・ファイルには、多くの航海における多くの測点データを保存できます。
3. 測点の「型」は一文字です(250層より少ない測点はB(例えばボトル採水データ)、250層より多い測点はC(例えばCTDやXBTなど)とします)。「型」に*を指定するとODVが選択します。
4. “Bot. Depth” (現場水深) がなければ、このフィールドは“0”(ゼロ) としてください。
5. 測点ヘッダー情報は(ヘッダー・カラムが含まれていれば)、全ての行に存在しなければなりません。

	品質フラグ・カラム

(Quality flag columns)
	1. ある変数のデータ品質情報が有効な場合は、この情報はその変数の直後に記載します。
2. 品質フラグは一桁の整数です: 0=good, 1=unknown, 4=questionable, 8=bad.

	欠測値(Missing data value) 
	空欄または良好なデータの範囲を越えた任意の数値。


上述のgeneral ODVスプレッドシート・フォーマットに加えて、より制約のあるgeneric ODVスプレッドシート・フォーマットと呼ばれるものもあり、ユーザーの操作なしにデータを読み込むことができ、ODVデスクトップ・アイコンや開かれたODVウィンドウにドラッグ&ドロップできます。できるだけgeneric ODVスプレッドシート・フォーマットに従うようにしてください。Generic ODVスプレッドシート・フォーマットの詳細な仕様は下の表の通りです。
4.1.2
Genericフォーマット(Generic Format)
	全般 (General)
	アスキーコード

	ファイル拡張子(File extension)
	.txt

	カラム(Columns)
	測点のヘッダー情報(メタデータ)と50個までの変数のデータ値は、分離されたカラムに保存されます。ヘッダーおよびデータのカラムの並びは任意です。ファイル中の全ての行は同じカラム数でなければなりません。

	カラム分離記号

(Column separation character)
	タブまたは ;

	一行目: カラム・ラベル

(First line: Column Labels)
	1. カラムのラベルを含みます。
2. 標準ヘッダー・ラベルは次の通りです: “Cruise”, “Station”, “Type”, “mon/day/yr”, “hh:mm”, “Lon (°E)”, “Lat (°N)”, “Bot. Depth [m]”.
3. データ変数のラベルは[ ]で囲まれる単位も含めて60文字までです。
4. データ変数の各カラムは、オプションとして変数の直後に品質フラグを持つことができます。品質フラグのカラムのラベルはQFあるいはQF:*のいずれかでなければなりません(*は任意の文字列)。

	二行目から最終行まで: データ行

(2nd until last line: Data Lines)
	1. 各行はメタデータと一つの観測層のデータを含んでいます。測点の全ての観測層は連続していなければなりませんが、並び替えられている必要はありません。一つのODVスプレッドシート・ファイルには、多くの航海の多くの測点データを保存できます。
2. 航海および測点のラベルは最大20文字までに限られています。測点ラベルで数字を使用すると、高度な内部ソートや選択が容易になるので推奨します。
3. 測点の「型」は一文字です(250層より少ない測点はB(例えばボトル採水データ)、250層より多い測点はC(例えばCTDやXBTなど)とします)。「型」に*を指定するとODVが選びます。

4. “Bot. Depth” がなければ、このフィールドは “0”(ゼロ) としてください。
5. 測点ヘッダー情報は全ての行に存在しなければなりません。

	品質フラグ・カラム

(Quality flag columns)
	1. ある変数のデータ品質情報が有効な場合は、この情報はその変数の直後に記載します。

2. 品質フラグは一桁の整数です: 0=good, 1=unknown, 4=questionable, 8=bad.

	欠測値(Missing data value)
	空欄または –1.e10


Generic ODVスプレッドシート・フォーマットのファイルの読み込みは、半自動的にODVが処理します: ヘッダー・カラムの指定にユーザーの操作は不要で、これらのファイルはODVデスクトップ・アイコンまたは開いているODVウィンドウにドラッグ&ドロップできます。
Generic ODVスプレッドシート・フォーマットから現在開いているコレクションにデータを読み込むためには、Import>SpreadSheetの順に選択し、読み込みたいデータの指定にはウィンドウズ標準のファイル選択ダイアログを使用してください。読み込みオプションを指定してOKを押すとデータの読み込みが始まります。
4.2
WOCE海洋観測データ (WOCE Hydrographic Data)

WOCE海洋観測データ(WHP Exchangeフォーマット)を現在開いているODVコレクションに読み込めます。まず初めに、WHP DAC (http://whpo.ucsd.edu/)からディスク上の空ディレクトリ(ソース・ディレクトリ)にデータファイルをダウンロードして下さい。ボトル採水データを読み込むにはODVのメインメニューからImport>WOCE WHP Bottle(exchange format)>Single Fileの順に選択して下さい。ディスク上のWHPデータセットの選択には標準のファイル選択ダイアログを使用します(WHP Exchangeファイルの標準の拡張子は.csvです; もしファイルの拡張子が違っていたら、ファイル選択ダイアログのファイル形式は “All files”を選択してください)。読み込みオプションを設定してOKを押すと読み込みを開始します。ODVはWOCEデータファイルの全測点を読み込みます。ODVは実データに加えてWOCEデータの品質フラグも識別して読み込みます。これらの品質フラグは後の解析で不良または疑わしデータを取り除くフィルターとして使えます。（地図ポップアップメニューからselect criteliaを選択(Sample Selectionタブを選択)するとデータ品質フィルターを修正できます。）

CTDデータを読み込むには、ODVのメインメニューからImport>WOCE WHP CTD(exchange format)>Single Fileの順に選択し、読み込みたいCTDデータが含まれている.zipファイルを選択します。必要ならばサブ・サンプリングデータを指定して下さい(初期設定ではサブ・サンプリングデータはありません)。ODVは.zipファイルの圧縮を解いて現在開いているコレクションにCTDの全測点を読み込みます。ODVは一測点あたり20,000層のデータを取り扱うことができます。測点がそれ以上のデータを持つ場合は切り捨てられます。

ODVはソースファイルの圧力データを水深値に自動変換します。もし変数として圧力データが必要な場合は導変数Pressure(Depth)を利用してください。

4.3
WOD海洋観測データ (WOD Hydrographic Data)

ODVでImport>World Ocean Database>Single Fileの順に選択すると、WOD配布CDのWorld Ocean Databaseディレクトリまたはオンライン・データファイルからオリジナル海洋観測データを読み込むことができます。読み込みたいWODデータセットの圧縮データファイル(*.gz)の指定には標準のWindowsファイル選択ダイアログを使用してください(すでに圧縮を解かれたWODファイルを選びたいときはファイル形式で “All Files (*.*)”を選んでください)。WODの測点に合うように測点選択基準を指定するか、OKを押すだけで、現在の地図領域に収まる全ての測点を読み込み、読み込みオプションを指定してからOKを押すとデータの読み込みが始まります。ODVは選択されたWODのデータファイルを読み取って、測点の選択基準を満たす全ての測点を読み込みます。読み込まれた測点の航海ラベルはWODの識別子、 例えば二桁のNODC国コードと六桁のOCLクルーズ番号に続く “WOD98”、“WOD01”等で構成されています。ODVはユニークな(他と重複しない)OCLプロファイル番号を測点番号として使用します。ODVは読み込みファイルに含まれるデータ品質フラグを認識して使用します。
同じ測点選択基準と読み込みオプションを使って、一度の読み込み操作で複数のWODファイルからデータを読み込むことができます。そうするには、読み込まれるファイル名(フルパス名で、一行につき一ファイル名)を含むアスキーファイル(初期設定の拡張子は.lst)を用意する必要があります。そしてImport>World Ocean Database>Multiple Fileの順に選択し、WODの測点に合う測点選択基準を指定し(現在の地図領域内に収まる全ての測点を読み込む場合はOKを押すだけ)、さらに読み込みオプションを指定してOKを押すとデータの読み込みが始まります。ODVはアスキーファイルに書かれた全ファイルを読み取って、測点選択基準を満たす全ての測点を読み込みます。
現在の地図領域内に収まる測点だけがコレクションに読み込まれます。全測点を読み込むには、読み込を開始する前に地図ポップアップメニューからGlobal Mapを選択してください。
4.4
WOA94海洋観測データ (WOA94 Hydrographic Data)

ODVでImport>World Ocean Atlas 94>Single Fileの順に選択してWorld Ocean Atlas 1994の配布CDからオリジナルの海洋データを直接読み込むことができます。読み込みたいWOA94データセットのデータファイル(*.ol)の指定には、標準のWindowsファイル選択ダイアログを使用してください。WOA94の測点に合う測点の選択基準を指定し(現在の地図領域内に収まる全ての測点を読み込む場合はOKを押すだけ)、さらに読み込みオプションを指定してからOKを押すとデータの読み込みが始まります。ODVは選択されたWOA94データファイルを読み取って、測点の選択基準を満たす全ての測点を読み込みます。
同じ測点選択基準と読み込みオプションを使って、一度の読み込み操作で複数のWOA94ファイルからデータを読み込むことができます。そうするには、読み込まれるファイル名(フルパス名で、一行につき一つのファイル名)を含むアスキーファイル(初期設定の拡張子は.lst)を用意する必要があります。そしてImport>World Ocean Atlas 94>Multiple Filesの順に選択して、WOA94の測点に合う測点選択基準を指定し(現在の地図領域内に収まる全ての測点を読み込む場合はOKを押すだけ)、さらに読み込みオプションを指定してOKを押せばデータの読み込みが始まります。ODVはアスキーファイルに記載された全ファイルを読み取って、測点の選択基準を満たす全ての測点を読み込みます。
現在の地図領域内に収まる測点だけがコレクションに読み込まれます。全ての測点を読み込むには、読み込を開始する前に地図ポップアップメニューからGlobal Mapを選択してください。

4.5
SD2海洋観測データ (SD2 Hydrographic Data)

ODVでImport>NODC SD2 Format>Single Fileの順に選択してNODC SD2ファイルからオリジナルの海洋観測データを読み込むことができます。読み込みたいデータファイルの指定には、標準のWindowsファイル選択ダイアログを使用してください。読み込みオプションを指定してOKを押すとデータの読み込みが始まります。
複数のSD2ファイルを読み込みたい時には、全てのSD2ファイルを一つのディレクトリに置いて、読み込みたいSD2のファイル名を入力したファイルを作ってください(初期設定のリスト・ファイルの拡張子は.lstで、一行につき一つのファイル名)。そしてImport>NODC SD2 Forma>Multiple Filesの順に選んでリスト・ファイルを選択します。
4.6
他の海洋観測データ (Other Hydrographic Data)

読み込みたい海洋観測データがWOCE WHP, WOA94, NODC SD2のいずれのフォーマットでもない時は、上述したODVスプレッドシート・フォーマットを使ってODVコレクションにデータを読み込ませることができます。旧バージョンとの互換性を保つために、長い航海ラベルと測点ラベルに加えて各々の実データ値に対する品質フラグを認めているODV4.xアスキーフォーマットを今でもODVはサポートしています。旧バージョンのODVを使っているユーザーはODV3.0アスキー交換フォーマットを通してデータを変換できます。
4.6.1
.o4x交換フォーマット (.o4x Exchange Format)

“.o4x”アスキー交換フォーマットは単一ファイルのフォーマットです。変数の情報と同時に読み込まれる全測点のデータ値および品質フラグは、一つのファイル(初期設定の拡張子は.o4x)に含まれます。このファイルは、データの型の情報と同様に変数の数およびラベルも最初に含んでいなければなりません(下記を参照するか、ODVサンプル・ディレクトリにあるimport4.o4xファイルを参照して下さい(訳注: ODV (mp) Version 1.3aでは$ODVMPHOME\samples\SampleFiles.zipの中に収録されています))。(下の例で見られる上と下の “....+.”行はルーラーを示していて、ファイルの一部ではありません) 。
“.o4x”変数部,の例
....+....1....+....2....+....3....+....4....+....5....+....6.... 

ODV4.0 Listing

 File Name: import4.o4x

      Type: HYD

     Nstat: 12

 Variables: 8

Depth [m]                                                    6.0

Temperature [°C]                                             8.2

Salinity [psu]                                               8.3

Oxygen [~$m~#mol/kg]                                         6.0

Phosphate [~$m~#mol/kg]                                      8.2

Silicate [~$m~#mol/kg]                                       8.1

Nitrate [~$m~#mol/kg]                                        7.1

Nitrite [~$m~#mol/kg]                                        6.1

....+....1....+....2....+....3....+....4....+....5....+....6.... 

測点のヘッダー行とデータファイルの変数部は一つの空行で分けられています(例えばODVサンプル・ディレクトリにあるimport4.o4xファイルを参照してください(訳注: ODV (mp) Version 1.3aでは$ODVMPHOME\samples\SampleFiles.zipの中に収録されています))。測点のヘッダー行の一桁目は #で始まります。これに続く項目は次の通りです: (1)測点の航海ラベル(3～22桁目; a20); (2)測点ラベル(24～43桁目; a20); (3) 測点タイプ(B, C, Xはそれぞれボトル採水、CTD、XBTデータ; 45桁目; a1); (4)日付mm/dd/yyyy(47～66桁目; i2, 1x, i2, 1x, i4); (5)東経(十進数; 58～64桁目; f7.3); (6)北緯(十進数; 66～72桁目; f7.3); (7)現場水深([m]; 74～78桁目; i5); (8)最深観測深度([m]; 80～84; i5); (9)観測層数(85～89桁目; i5); (10)ファイル内の変数の数(91～93桁目; i3)。このファイルの例では、測点06MT18/558の型はボトル採水で、14層の観測深度のそれぞれに8個の変数が続いています。これらの変数は、(ファイルの初めにある変数部で定義されているような)第二ヘッダー部の変数の並びと一致しなければなりません(例えば、1なら水深を、6ならケイ酸塩を意味します)。フォーマットの唯一の制約は、第二ヘッダー部の変数番号が少なくとも一つの空白で区切られていなければならないことです。
各観測水深(この例では14層)につき、一つのデータ行があります。これらの各行には、第二ヘッダー部で示されている順に並んでいるデータ値と品質フラグが含まれていなければなりません。欠測値はデータファイル中で-1.000E+10とします。データと品質フラグとは少なくとも一つの空白で分けられていなければなりません。品質フラグは一桁の整数で、0=good, 1=unknown, 4=questionable, 8=badを意味します。測点の最終データ行の直後には、読み込まれる次の測点の(#で始まる)第一ヘッダー行が、あるいはそれが読み込まれる最後の測点ならばend-of-file(ファイルの終わりを示す記号)が続きます。
“.o4x”ファイルを作成してから、ODVを実行させて新しいデータのためのコレクションを開くか作成して下さい。そしてImport メニューからODV4.x Listingを選択して、上記で作成したアスキーデータファイルを読み込みファイルとして選んで、読み込みオプションを指定してOKを押せばデータの読み込みが始まります。その後ODVは読み取りファイルにアクセスしてコレクションに測点を追加／統合します。ODV上に.o4xファイルをドラッグ&ドロップすることもできます。

4.6.2
.o3x交換フォーマット (.o3x Exchange Format)

“.o3x”交換フォーマットのデータを読み込むには、二つのアスキーファイルを用意する必要があります: 一つは、読み込みたい全測点の実データを含んだもの(初期設定の拡張子は.o3x)、もう一つは、データファイルに含まれる変数を記述する(小さい)ファイルです(拡張子は.varでなければなりません)。
“.var”ファイルの例

....+....1....+....2....+....3....+....4....+....5....+....6....

ODV4.0

Collection: SAVE

      Type: HYD

     Nstat: 0

 Variables: 7

Depth [m]                                                    6.0

Temperature [°C]                                             8.2

Salinity [psu]                                               8.3

Oxygen [~$m~#mol/kg]                                         6.0

Phosphate [~$m~#mol/kg]                                      8.2

Silicate [~$m~#mol/kg]                                       8.1

Nitrate [~$m~#mol/kg]                                        7.1

....+....1....+....2....+....3....+....4....+....5....+....6....

上と下の“....+”行は単なるルーラーであって、.varファイルの一部ではありません。また、.varファイルはODV4.xコレクションの定義ファイルと同じフォーマットですが、データの読み込みに必要な情報は変数に関する記載に限られます。読み込むデータファイルに含まれる変数の数の指定は、五行目の13桁目から始めなければなりません。そして一つの空行の後に、全変数の変数ラベルと数値フォーマットを変数毎の行で与える必要があります。数値フォーマットは61桁目から始まり、 ll.dの形式で表示されます(ここでllは文字列の全長で、dは小数点以下の桁数を示します)。
“.o3x”ヘッダー行の例

....+....1....+....2....+....3....+....4....+....5....+....6....+....7...

# REID_ET           212 B  6/21/1967 243.167 -28.233  3400  3310   34   7

    1    2    3    4    5    6    7

読み込む全測点のデータは単独のアスキーファイルでなければなりません(初期設定の拡張子は.o3x)。このファイルは以下のフォーマット仕様と一致しなければなりません(最上部のルーラーはファイルの一部ではありません):

ファイルは読み込む最初の測点のヘッダー行から開始します。測点ヘッダー行は一桁目の#から始まらなければなりません。各項目は以下の通りです: (1)測点の航海ラベル(3～12桁目、a10); (2)測点ラベル(14～23桁目、a10); (3)測点タイプ(B, C, Xはそれぞれボトル採水、CTD、XBTデータ; 25桁目; a1); (4)日付mm/dd/yyyy(27～36桁目; i2, 1x, i2, 1x, i4); (5)東経(十進数; 38～44桁目; f7.3); (6)北緯(十進数; 46～52桁目、f7.3); (7)現場水深([m]; 54～58桁目; i5); (8)最深観測層深度([m]; 60～64桁目; i5); (9)観測層数(66～69桁目; i4); (10)ファイル内の変数の数(71～73桁目; i3)。上述の例では、測点 REID_ET/212で測点の型はボトル採水、34層の観測深度のそれぞれに7個の変数のデータが続いています。これらの変数は.varファイルの第二ヘッダー部にある変数の並びと一致しなければなりません(例えば、1なら水深を、6ならケイ酸塩を意味します)。フォーマットの唯一の制約は、第二ヘッダー部の変数番号が少なくとも一つの空白で区切られていなければならないことです。
各観測深度(上述の例では34層)について、一つのデータ行が続かなければなりません。これらの各行は、第二ヘッダー部で示されている順に並んだ数値が含まれなれなければなりません。欠測値はデータファイル中で-1.000E+10とします。ある測点の最終データ行の直後には、読み込まれる次の測点の(#で始まる)第一ヘッダー行が、あるいはそれが読み込まれる最後の測点ならばend-of-file(ファイルの終わりを示す記号)が続きます。
“.var” と “.o3x” ファイルを作成した後は、ODVを実行して新しいデータのためのコレクションを開くか作成して下さい。そしてImportメニューからODV3.x Listingを選択して、上記で作成したアスキーデータファイルを読み込みファイルとして選び、読み込みオプションを指定してOKを押せばデータの読み込みが始まります。その後ODVは読み取りファイルにアクセスしてコレクションに測点を追加／統合します。ODV3.0交換フォーマットからデータを読み込んだときのデータ品質フラグはUnknownにセットされます。

4.7
読み込みオプション・ダイアログ (Import Options Dialog)

	データを読み込む時にはImport Optionsダイアログが現れ、データ読み込み時の動作を定義するようユーザーに促します。
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Import Mode

Add/Replace Station Data: コレクションに読み込みファイルのデータを追加したい時に選択してください。Check for Existing Stationsボックスがチェックされていると、ODVは同じ名前、日付、位置を持つ測点をコレクションから検索し、そして(もし見つかれば)コレクション中の既存の測点を読み込みファイルの新しい測点と入れ替えるための許可を問い合わせてきます(測点検索手順の詳細は下記のCruise Label Associationを参照)。
Merge Data (selected variables): 一つ以上の変数(結合する変数)のデータを追加して、他の変数の既存データは変更したくない時に選んでください。ある層の 「結合する変数(merge variable)」の「結合値」は、下の表のように既存値か新規値かによって変わります:
	既存値

(Existing value)
	新規値
(New value)
	結合値
(Merged value)

	Yes
	yes
	既存値と新規値との平均値

	Yes
	no
	既存値

	No
	yes
	新規値

	No
	no
	欠測値


Check for Existing Stationsボックスは、このモードの時は選べません。データを追加する前に、ODVは一致する測点をコレクションから検索し(測点検索手順の詳細は下記のCruise Label Associationを参照)、もし見つかれば、コレクションからオリジナルの測点を読み取って、選択された変数のデータを追加し、オリジナルの測点を更新されたものと入れ替えます。一致する測点が見つからなければユーザーに通知されます。

Update Data (selected variables): 一つ以上の変数(更新する変数)のデータを更新して、他の変数の既存データは変更したくない時に選択してください。ある層における「更新する変数(update variable)」の「更新値」は新規の変数値だけに依存し、既存値は破棄されます。Check for Existing Stationsボックスはこのモードでは選択できません。データを追加する前に、ODVは一致する測点をコレクションから検索し(測点検索手順の詳細は下記のCruise Label Associationを参照)、もし見つかれば、コレクションからオリジナルの測点を読み取り、選択された変数のデータを更新して、オリジナルの測点を更新されたものと入れ替えます。一致する測点が見つからなければユーザーに通知します。
Cruise Label Association

データの入れ替えや結合の際に、ODVはまず初めに読み込まれる測点と一致する既存の測点をターゲット・コレクションから検索する必要があります。この検索では航海名、測点名、測点タイプ、緯度・経度、日付を比較します。一致の条件は航海名を除く全項目が同じことです。航海名については、TargetとSourceのコンボ･ボックスを用いて別名を作成することができます。例えば、06MT15/3という既存のコレクションの測点とMETEOR15/3という航海名の読み込みファイルの測点が同じであれば、まずTargetコンボ･ボックスから06MT15/3を選択して、それからソース・フィールドにMETEOR15/3と入力して別名を設定することができます。ソース・フィールドのデフォルト値はターゲット名と同じなので、読み込みファイル名と既存コレクションの航海ラベルが同じ場合には、Cruise Label Associationで全てを修正する必要はありません。
Variable Association

通常、読み込みファイルに保存されている変数の数、並び、意味は、コレクションのそれらとは異なるので、変数のソース／ターゲットを関連付けしなければなりません。ODVはラベル(名前と単位)が一致すれば自動的に変数を関連付けます。関連付けられた変数には*が付き、その変数をクリックすれば関連付けられた変数が判ります。

手動で変数を関連付けるには、ソース変数をクリックしてから、そのソース変数に関連付けたいターゲット変数をクリックし、AssociateまたはConvertのいずれかのボタンを押します。読み込みファイルのデータ値を無修整で読み込む場合にはAssociateを使用し、読み込み中に単位の変換が必要な場合には Convertを使用して下さい。Convertを使うと、あらかじめ定義された共通の変換の中から選ぶことができ、自ら定義した一般的な線形変換式も確立することもできます。

ODVスプレッドシートを読み込むとき、読み込みファイル中のソース変数に対応しないターゲット変数を初期設定値として設定ができます。これは、例えば三つのカラムX/Y/Zを含んでいるアスキーファイルからある数量Zの経緯度座標を読み込みたいが、指定した表面または水深が含まれていない場合に役立ちます。ターゲット変数にデフォルト値をセットするには、まず初めにTarget Collectionリストの中から変数を選びます。次にUse Defaultボタンを押して、このターゲット変数にふさわしい初期設定値を入力して下さい。このターゲット変数には+が付きます。指定した値は、この操作によって読み込まれるあらゆる測点のあらゆる観測層で使用されます。
ターゲット変数に関連付けられないソース変数はコレクションに読み込まれません。コレクションにデータを追加したければ、コレクションに追加したい変数だけを関連付けして下さい。どのODVコレクションでも第一変数には関連付けが必要です。
5
データの出力 (Exporting Data)

5.1
スプレッドシート・ファイル (Spreadsheet Files)

ODVのメインメニューからExport>ODV SpreadSheetの順に選択すると、単独のアスキースプレッドシート・ファイルに現在選択している測点データを出力できます。出力ファイルに含めたい変数を選択し(初期設定では全変数)、標準ファイル選択ダイアログ・ボックスを使って出力するディレクトリとファイル名を指定します。スプレッドシート・ファイルはImport>ODV SpreadSheetを使用して再読み込みが可能です。またODVスプレッドシート名にはスペースや “\”, “/”, “:”の文字を含めないでください。

5.2
ODVコレクション (ODV Collection)

ODVのメインメニューからExport>ODV Collectionの順に選択すると、新しいODVコレクションに現在選択している測点のデータを出力できます。新規コクションに含めたい変数を選択し(初期設定では全変数)、標準ファイル選択ダイアログ・ボックスを使って出力するディレクトリとファイル名を指定して下さい。ODVコレクション名にスペースや “\”, “/”, “:”の文字を含めないでください。

5.3
アスキーリスト (ASCII Listings)

ODVのメインメニューからExport>ODV ODV4.x Listingの順に選択すると、単独のアスキーリストファイルに現在選択している測点のデータを出力できます。出力ファイルに含めたい変数を選択し(初期設定では全変数)、Windows標準のファイル選択ダイアログ・ボックスを使って出力するディレクトリとファイル名を指定してください。ODV4.xリスト・ファイルはImport>ODV4.x Listingを使って再読み込みできます。ODV4.xリスト・フォーマットのより詳細な情報を見るにはここをクリックして下さい。ODVリスト・ファイル名にスペースや “\”, “/”, “:”の文字を含めないでください。

5.4
プロット値の出力 (Exporting Plot Values)

後々の処理(平均化、グリッド化、等値化など)のために、ODVのメインメニューからExport>Export Plot Valuesの順に選択して、ODVプロット・ウィンドウに表示されたデータ値をアスキーファイルに出力できます。この出力データを識別する説明文(txtID)を入力してOKをクリックしてください。ODVはローカルODVディレクトリ(通常<home>\odv_local)の下にexport\txtIDの名前でサブディレクトリを作成します。出力される全ファイルは、このディレクトリに書き込まれます。既に同じファイルが存在する場合、ODVは続ける前にディレクトリから全ファイルを削除する許可を問い合わせてきます。出力ファイル名は “win?”(ここで “?”は各々のウィンドウの番号を表す)から始まります。実際のx-y-z-sigma_zデータは、win?.oaiファイルにあります(一行につき一点のデータ)。
グリッド・フィールドのウィンドウでは、ODVはグリッド化処理(win?.oaoファイル)の結果も出力します。 “.oao”ファイルのフォーマットは次の通りです:
0
(無視)

nx  ny
( xとyのグリッド・ポイント数)

... nx X-grid values ...
(Xグリッドの位置)

... ny Y-grid values ...
(Yグリッドの位置)

... nx*ny gridded values ...
(評価フィールド、最初にYグリッド値から始まるX行×Y行)

6
導変数 (Derived Variables)

コレクションファイルに保存される基本変数に加えて、ODVでは非常に多くの導変数(derived variables)を計算でき、(一度定義すれば)基本変数と同様に解析やデータプロットに使用できます。導変数には次の三種類があります:
· 組込導変数(built-in derived variables): 多くの一般的な海洋物理・海洋化学のパラメータが含まれています。
· マクロファイル(macro files): ユーザー定義による数式がファイルに保存されたもので、任意のODVコレクションで使用できます。
· 数式(expressions): ユーザーが「その場(on-the-fly)」で定義するもの、現在のコレクションだけに使われます。
導変数を定義または削除するには、背景ポップアップメニューからDerived Variablesを選択するか、あるいはメインメニューからConfiguration>Derived Variablesの順に選択してください。マクロを追加するにはChoicesリストからマクロファイルを選んで下さい; ユーザー定義済みの数式の追加にはExpressionを選びます。組込導変数の追加はChoicesリストのその他の項目を選んで下さい。
6.1
組込導変数 (Built-in Derived Variables)

任意の基準圧力からのポテンシャル温度やポテンシャル密度、中立密度、Brunt-Väisälä (ブラント─バイサラ)周波数、力学的高度など海洋物理学で一般的に用いられている多くのパラメータのアルゴリズムがODVには組み込まれており、その場(on-the-fly)で計算や解析ができます。これらに加えて、海洋化学に関する多くの変数や、例えば鉛直積分や微分のような有益な数学計算機能もあります。利用可能な組込導変数のリストは以下の通りです。
組込導変数の定義および削除には背景ポップアップメニューからDerived Variablesを選択してください。ODVは利用可能な定義済み導変数のリスト・ボックスを表示します。導変数を追加するにはChoicesリストで項目を選んでクリックするかAddを押すか、その項目をダブルクリックします。ポテンシャル温度やポテンシャル密度のような一部の変数では追加情報が求められます(例えば基準圧力)。この情報を入力してOKを押してください。飽和酸素のような他の導変数では、適切な入力変数の識別が求められます。導変数の削除には、Already Definedリスト・ボックスにある変数をクリックして、Deleteを押すか、削除したい項目を単にダブルクリックしてください。他の導変数から入力を求められている変数を削除するときには、これらの数量も同様に削除されてしまいます。
組込導変数のリスト(List of built-in derived variables)
	変数(Variable)
	コメント(Comment)

	AOU [umol/kg]
	Apparent oxygen utilization

	Brunt-Väisälä frequency [cycl/h]
	EOS80

	CFC-11 Saturation [%]
	Warner & Weiss, Deep Sea Res., 32,1485-1497,1985

	CFC-12 Saturation [%]
	Warner & Weiss, Deep Sea Res., 32,1485-1497,1985

	CFC-10 Saturation [%]
	Bullister & Wisegarver, Deep Sea Res., 45,1285-1302,1998

	CFC-113 Saturation [%]
	Bu & Warner, Deep Sea Res., 42,1151-1161,1995

	CH4 Saturation [%]
	Wiesenburg & Guinasso, J. Chem. Eng. Data, 24, 356-, 1979

	CO2 (TCO2, TALK) [umol/kg]
	Dickson and Goyet, DOE Handbook, 1991

	CO3- - (TCO2, TALK) [umol/kg]
	Dickson and Goyet, DOE Handbook, 1991

	Day of Year (header mon/day/year) [days]
	Day of the Year [days] derived from header mon/day/year

	Day of Year (time variable) [days]
	Day of the Year [days] derived from a time variable

	Difference from Reference Data
	(details)

	Dynamic Height [dyn m]
	EOS80 (any reference pressure)

	Freezing Temperature [°C]
	F.Millero, UNESCO Tech. Papers in the Marine Science, No. 28., 29-35, 1978

	HCO3- (TCO2, TALK) [umol/kg]
	Dickson and Goyet, DOE Handbook, 1991

	Latitude
	

	Longitude
	

	Neutral Density [kg/m3]
	Jackett & McDougall, J. Phys. Ocean., 237-263, 1997

	Oxygen Saturation [%]
	Weiss, Deep Sea Res., 17, 721-735, 1970

	pCFC-11 [pptv]
	Warner & Weiss, Deep Sea Res., 32,1485-1497,1985

	pCFC-12 [pptv]
	Warner & Weiss, Deep Sea Res., 32,1485-1497,1985

	pCFC-10 [pptv]
	Bullister & Wisegarver, Deep Sea Res., 45,1285-1302,1998

	pCFC-113 [pptv]
	Bu & Warner, Deep Sea Res., 42,1151-1161,1995

	pCH4 [ppbv]
	Wiesenburg & Guinasso, J. Chem. Eng. Data, 24, 356-, 1979

	pCO2 (TCO2,TALK) [uAtm]
	Dickson and Goyet, DOE Handbook, 1991; Weiss 74

	pH (TCO2,TALK) 
	Dickson and Goyet, DOE Handbook, 1991

	Potential Density [kg/m3]
	EOS80 (any reference pressure)

	Potential Temperature [°C]
	Bryden, Deep Sea Res., 20, 401-408, 1973 (any reference pressure)

	Pressure [db]
	Saunders, J. Phys. Ocean., 1981

	Ratio
	Any two variables

	Sound Speed [m/s]
	Chen & Millero 1977, jasa, 62, 1129-1135

	Specific Heat Cp [J/(kg °C)]
	F. Millero et al, J. Geoph. Res., 78, 4499-4507, 1973

	Time (header mon/day/year) [yr]
	Decimal time [yr] derived from header mon/day/year

	Time (time variable) [yr]
	Decimal time [yr] derived from a time variable

	Vertical Derivative
	Any variable

	Second Vertical Derivative
	Any variable

	Vertical Integral
	Any variable


鉛直積分(Vertical Integral):

ユーザーは、鉛直積分を計算する変数を選択し(以降ではAとする; 基本変数または定義済み導変数が使用可能)、積分の開始水深 z0 を指定します(初期設定: 0m)。ある測点の各観測層に対し、ODVは z0 から各々の層までの積分A×dzを計算します。積分の単位は、数量Aの単位×長さ(ODVではkmを使用)です。体積濃度単位(例えばモル／立方メートル)の変数の積分は“standing stock per square meters”(例えば単位水柱中のモル総量)になります。定義によってはz0の積分値がゼロになります。（例: 水柱の海面から500mまでの塩分の構成物質(salt content)を求めるには、積分の変数として塩分を選択し、開始値には0を使用します。それから (近傍点の間で内挿によって)500mでの鉛直積分値を調べるか、SURFACEモードにおける等値面変数のように水深=500での積分を定義してください。
6.2
導変数のマクロ (Macros of Derived Variables)

ある層における新しい導変数の値が、そこと同じ層の他の変数だけに依存するのであれば、組込量のリストには含まれていない新しい導変数を実装できます。このような場合は、マクロファイルに入力変数と新しい組込量の式を指定してください。マクロファイルの拡張子は.macで、ODVマクロ・ディレクトリ(通常はc:\Program Files\Ocean Data View (mp)\Include\Macros)に置かれなければなりません。また、フォーマットは以下の仕様に従っている必要があります。マクロの定義を簡単にするためにODVマクロ・エディタが使えます(Utilities>Invoke Macro Editorで呼び出します)。ODVと共に配布されている実例マクロファイルは独自に定義するためのサンプルファイルとして使えます。
マクロ導変数を使うには背景ポップアップメニューからDerived Variablesを選んで、利用可能な数量のリストからMacro Fileを選択してください。そしてODVマクロ・ディレクトリ(通常は<home>\odv_local\macros)の中にあるマクロファイルを一つ選んで、新しい数量の計算に必要な変数を指定してください。必要な変数の内の一つでも利用できなければCancelを押してマクロファイルのセットアップを中止して下さい。

6.2.1
マクロ・エディタ (Macro Editor)

Ocean Data ViewマクロファイルはUtilities>Invoke Macro Editorオプションを使って作成編集できます。既存のマクロファイルを選択するか新規マクロ名を選んで、下記に示した手順に従ってマクロを定義してください。
マクロ変数 (Macro Variable)

ラベル(Label):
マクロ変数のラベルと単位を入力します。次の整形文字が使えます:
~$           記号フォント(ギリシャ文字)へ切り替える
~#           通常のテキスト・フォントへ切り替える
~%          パーミル記号を生成する
~^           次の文字を上付きにする
~_           次の文字を下付きにする
フォーマット(Format):
ODVテキストウィンドウに数値フォーマット(フィールド長と小数点以下の桁数)を入力
コメント(Comments)
マクロ変数を説明する一行以上のコメントを入力する。
入力変数(Input Variables)
マクロ変数に必要な入力変数のリスト。入力変数の追加には、Newフィールドにそのラベルと単位を入力して “<<”ボタンを押してください(上述の整形文字が使えます)。定義済み入力変数を削除するには、Definedリスト・ボックスの中からそれを選んで、“>>”ボタンを押して下さい。ODVマクロは最大9個の入力変数を扱えます。
数式(Expression)

数式フィールドには、マクロ変数の計算を実行する演算を指定します。
基本的な算術演算子 + - * / **、平方根sqrt 、先行する二つの被演算子の最大または最小をとるmin と max 、自然対数ln 、指数関数 exp 、正弦sin と余弦cos (引数はラジアン)が使えます。Hewlett-Packardの計算機のように(被演算子を演算子より先行させて)マクロ式を入力してください。例えば、#1は一番目(#1)の入力変数値を参照します。記号%t, %d, %x, %yは、それぞれ観測時刻(1900年からの年; 例えば%t=84.4877はJun/27/84を示します)、年における日数、東経、北緯を参照します。個々の項目(被演算子と演算子)は少なくとも一個の空白で区切って、必要ならば次の行に続けてマクロ式を定義してください。演算式の定義の総文字数は500までです。

6.2.2
ODV マクロフォーマット(ODV Macro Format):

マクロファイル po.mac の例:

ODV4.0 Macro

>|--->----------------------------------------------------------|>--|

     PO [~$m~#mol/kg]                                             5.0

#1   Phosphate [~$m~#mol/kg]

#2   Oxygen [~$m~#mol/kg]

135 #1 *  #2 +

ODVマクロファイルの最初の行は文字列ODV4.0 Macroで、識別の目的にのみ使用されます。二行目は、ファイルの残りの行を容易に整形するためのルーラーです。新規導変数の実際の定義は三行目から始まり、六桁目から新しい変数のラベルが置かれ、ODVテキストウィンドウでの表示は66桁目から始まる数値フォーマットll.dに従います。ここでllはテキストフィールドの長さを、dは小数点以下の桁数を表します。以降は、新規変数の計算に使われる他の(基本または定義済み導)変数が一行につき一個づつ続きます。これらの行は、一桁目の#に続く一桁の数字(1, 2 , ...9の順)で始まります。 使用される数量を説明する名前を六桁目から入力してください。変数ラベルには制御文字として上述したギリシャ文字、上付き文字、下付き文字が使えます。
一つの測点の各観測層に対して実行される代数演算の実際の定義は、計算に使われる変数のブロックと一つの空行で区切られます(上述のマクロファイルの例を参照)。基本算術演算子 + - * / **, 先行する二つの被演算子の最大または最小をとるminとmax、自然対数ln、指数関数exp、正弦sin、余弦cos (引数はラジアン)が使用可能です。Hewlett-Packardの計算機のように(被演算子を演算子より先行させて)マクロ式を入力してください。例えば、#1は一番目(#1)の入力変数値を参照します。記号%t, %d, %x, %yは、それぞれ観測時刻(1900年からの年; 例えば%t=84.4877はJun/27/84を示します)、年における日数、東経、北緯を参照します。個々の項目(被演算子と演算子)は少なくとも一個の空白で区切って、必要ならば次の行に続けてマクロ式を定義してください。演算式の定義における全文字数は500までです。ODVで同時に動作するマクロの最大数は10個です。
数量PO = 135 * PO4 + O2を計算する上述の例において、数列135 #1 * は135と現在の層の第一変数値との積を生成します。一度実行すると、数列135 #1 * は掛算の結果に置き換えられ、それから第二変数の値が加えられます。一つ以上入力変数が計測されていなければ、導変量の値には-1.e10(欠測値)がセットされます。
ODVのマクロ機能は広範囲に適用できるように一般化しています。以下に二つの例を示します。
(a) t0を基準とした放射性トレーサーの減衰(ここではt0=1980; τ=17.6年とします):

T(t0) = T(t) e(t - t0)/τ
ODV4.0 Macro

>|--->----------------------------------------------------------|>--|

     Trit80 [TU]                                                  7.2

#1   Tritium [TU] 

%t 80 - 17.6 / exp #1 *

(b) 水塊特性の複数のパラメータ距離(ここではポテンシャル水温、塩分、ケイ酸塩を使用):

C = {(c - c0) / σ }2  + ...

ODV4.0 Macro

>|--->----------------------------------------------------------|>--|

     MP-Dist{10,34.7,25}                                          7.0

#1   Tpot [C]

#2   Salinity [psu]

#3   Silicate [umol/kg]

#1 10   - 0.1  / 2 ** 

#2 34.7 - 0.05 / 2 ** +

#3 25   - 0.5  / 2 ** +

6.3
数式 (Expressions)

数式はマクロに似ていて、同じ機能セットを使用し、ほとんど同じ方法で定義できます。数式の定義がファイルに保存されないことがマクロと大きく違う点で、また、数式は編集できません。数式は、新しく考案した導数量(derived quantities)を素早くチェックするのに適しています。数式の適用範囲は定義済みのコレクションに限られています。数式が複雑な場合、または同じ数式を異なる多くのコレクションに対して使いたい場合はマクロファイルを作ってください。
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導変数の数式をセットアップするには、背景ポップアップメニューからDerived Variablesを選択し、利用可能な数量のリストからExpressionを選んでAddを押してください。するとODVはマクロエディタ・ダイアログと同様のダイアログを表示します。ここで、ラベルフィールドに新規変数のラベルと単位を入力してください。それから新規変数に必要な入力変数を選びます; 例えば変数をChoicesリストから変数を選んで “<-”を押します。最後に新しい数量を評価する数式を指定して下さい。基本算術演算子 + - * / **, 先行する二つの被演算子の最大または最小をとるminとmax、自然対数ln、指数関数exp、正弦sin、余弦cos (引数はラジアン)が使用可能です。Hewlett-Packardの計算機のように(被演算子を演算子より先行させて)マクロ式を入力してください。例えば、#1は一番目(#1)の入力変数値を参照します。記号%t, %d, %x, %yは、それぞれ観測時刻(1900年からの年; 例えば%t=84.4877はJun/27/84を示します)、年における日数、東経、北緯を参照します。個々の項目(被演算子と演算子)は少なくとも一個の空白で区切って、必要ならば次の行に続けてマクロ式を定義してください。数式定義の総文字数は500までです。新しい数式のセットアップを完了させるにはOKを押して下さい。
数式は編集できません。もしアルゴリズムを修正したければ、古い数式を削除してから新しい数式を定義しなければなりません。
7
ODVの使用 (Using ODV)

7.1
現在のサンプルおよび測点の選択 (Choosing Current Sample and Current Station)

ODVでコレクションを開いて測点図が描かれた時、地図上に示される有効な測点の一つが現在の測点です。この測点は赤丸で印されて、ヘッダーとデータ情報がODVのテキストウィンドウに表示されます。新しく現在の測点を選択するにはいくつかの方法があります:
(1) 地図上の任意の測点をマウスの左ボタンでクリックする。同じ位置に複数の測点があるときは(リピート観測、係留観測など)、シフトキーを押しながらマウスの左ボタンをクリックしてください。するとODVは一致する測点のリストを表示するので、そのリストから一つを選んでください。シフトキーを押していなければ、初期設定によって最初に一致した測点が選ばれます。
(2) 地図ポップアップメニューからSelect Station by Nameを選んで、航海ラベル、測点ラベル、測点タイプを指定します。
(3) 地図ポップアップメニューからSelect Station by Numberを選んで(または単に#を押して)、測点の内部連続番号を指定します。
右矢印キー(->)を押すと次の有効な測点に進み、左矢印キー(<-)を押すと前の測点に戻ります。
現在の測点におけるサンプルの一つが現在のサンプルとなり、このサンプルのデータ値はODVテキストウィンドウの三行目に表示されます。画面上にデータプロットがあれば、現在のサンプルもまた各プロット中に赤の十字記号で印されます。同じ測点の深い方または浅い方の新しいサンプルはup/downとPgUp/PgDnキーを押して選べます。または単にマウスの左ボタンでクリックして、データプロットの任意のデータ点を現在のサンプルにできます。
テキストウィンドウの二行目または三行目の上にマウスを動かすと、品質フラグを含むデータ値の詳細な情報が得られます。テキストウィンドウに表示される変数の数値フォーマットと順序はテキストウィンドウ・ポップアップ・メニューのVariables Settingsで変更できます。
7.2
変数設定の変更 (Changing Variable Settings)

ODVテキストウィンドウの三行目に表示される変数のラベル、最小／最大領域の初期設定、数値フォーマット、位置は、テキストウィンド・ポップアップメニューのVariables Settingsオプションを使って変更できます(テキストウィンドウ上でマウスの右ボタンをクリックしてVariables Settingsを選択してください)。
最初にVariable コントロールを使って修正したい変数を選択します(右クリックをしたときに各々の変数上にあれば、この変数があらかじめ選択されていることになります)。そして、この変数の異なるプロパティを修正して下さい。Label項目を編集すると、変数ラベルと単位の文字列が変更されます。単位は括弧[ ]で括ってください。MinimumとMaximumの項目を設定すると、変数の上限と下限の初期設定値を変えられます。Format項目を設定すると、テキストウィンドウの三行目にある変数のリストデータで使われる数値フォーマットを修正できます。最初の数字でフィールドの長さ(文字数)を指定し、二番目の数字で小数点以下の桁数を指定します。最後に、Positionコンボボックスを使ってテキストウィンドウの変数の位置を変更できます(変数の新しい位置が選択できます; 例えば(現場)水温の次にポテンシャル水温)。引き続き他の変数を変更し(Variableコンボボックスを使って選択します)、OKを押して実行して下さい。
7.3
選択基準の変更 (Changing Selection Criteria)
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測点図を描画するとき、ODVはコレクション中の各測点をチェックして、現在の測点選択基準を満たすかどうかを調べます。このチェックを通過した測点だけが有効とみなされ、これらだけが地図上に表示されて以降の閲覧やプロットに使用されます。測点およびサンプルの選択基準を修正するには地図ポップアップメニューのSelection CriteriaあるいはメインメニューのConfiguration>Selection Criteriaを使ってください。それぞれのタブ、例えばName/Range, Date/Time, Availability，Sample Selectionをクリックして修正したいカテゴリーを選択し、様々な項目を設定します。

Name/Rangeタブでは、航海ラベルの選択、航海ラベルのワイルドカードの指定、測点ラベルの範囲の指定、測点タイプの選択、内部順番号の範囲の設定、現場水深と深層部の観測の範囲を設定できます。航海ラベルに関するワイルドカード・パタンとして以下の文字を指定できます:

· c
自分自身を意味する任意の文字。すなわちcは文字cに合致します。

· ?
任意の一文字に合致。例: SAVE_LEG?.

· *
0文字以上の任意の文字に合致。例: I01_*, *06AQ*

· […]
かぎ括弧内に表された文字列のセット。文字クラスの中では逆スラッシュは特別な意味を持ちません。例: [abc], [A-W], [0-9], I05[EW]_316N145_?

Domainカテゴリーでは、各々の緯度経度の数値を指定して地図の矩形の副領域を定義できます。またはZoomボタンを押して拡大する矩形を定義できます。Polygonボタンを押してマウスで多角形の頂点を入力すると、その多角形を有効な領域として定義できます。多角形は自動的に閉じられます。Availabilityカテゴリーでは、測点が有効と見なされるために存在しなければならない一つ以上の変数を印します。Sample Selectionカテゴリーでは、指定した変数(Validate Variable)の範囲の指定、またはデータ品質レベルの要求によるデータ品質フィルターを設定できます。Validate Variableに関して、ある範囲外の値を持つ全てのサンプルは除外されます。カテゴリーの選択基準を緩和するには、各々のページのRelax Criteriaボタンを押してください。設定が完了したらOKを押します。ODVは新しい選択基準を用いて測点図を再描画します。

7.4
地図投影法の変更 (Changing Map Projections)

地図ポップアップメニューのDisplay Optionsを使って地図投影法を変更できます。Generaタブを選択して、Map Projectionコンボボックスから投影法を一つ選んでください。次の投影法が利用可能です: (1)初期設定の投影法, (2)正射図法(北極)(Orthographic (North Polar)), (3)正射図法(赤道)(Orthographic (Equatorial)), (4)正射図法(南極)(Orthographic (South Polar)), (5)正射図法(一般)(Orthographic (General)), (6)モルワイデ図法(Mollweide)。初期設定の投影法では経緯度方向が線形です。正射図法は半球ですが、初期設定の図法とモルワイデ図法は全球です。全ての投影法において、拡大またはMap Display OptionsダイアログのDomainタブを使った副領域の定義が可能です。正射図法(一般)では、全球を表示させる任意の緯度／経度の視点(極)を指定できます。他の投影法では極緯度は固定されていて、極経度だけ変更できます。
(2)から(6)の投影法では、拡大による副領域の定義が難しいので、精密な結果が必要ならMap Display OptionsダイアログのDomainタブを使用するか、一旦、初期設定の投影法に切り替えて拡大(それから副領域を定義)して、最後に希望する地図投影法に戻します。
他の地図表示オプションの詳細は表示オプションの変更を参照してください。
7.5
全画面測点図 (Full Screen Station Maps)
背景ポップアップメニューからMAPモードを選んで、全画面の測点図を描画できます。ダブルクリックで地図中の測点にラベル付けができ、また、削除(Del)ボタンを押して現在の測点の注釈を取り除けます。注釈の位置は、測点の位置とダブルクリックしたときのマウスの位置との関係に依存しますので、試してみてください。Display Optionsダイアログ・ボックスで注釈のスタイルとフォントサイズを変更できます。File>Printを選択すると測点図のハードコピーを作成できます。またはメインメニューからFile>Save Asの順に選択して地図のPostScript、PNGまたはJPGファイルを作成できるので、希望するフォーマットを選んでください。
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8
成分間プロット (Property-Property Plots)

ODVがSTATIONモードのとき(ウィンドウの右下隅に示されます; 背景ポップアップメニューからSTATION Modeを選んでSTATIONモードに切り替えられます)、pキーを押すか地図上の現在の測点でマウスの左ボタンをダブルクリックすると、現在の測点の成分間プロット(property/property plots)が作成されます。他の測点のデータをプロットに追加するには、追加する測点をダブルクリックするか、または現在の測点にしてからそれらを選択してpキーを押してください。プロットから選択されている測点の一つを削除するには、現在の測点にして(例えば一つのプロットで、その測点の一つをクリックして)、削除(Del)キーを押してください。画面をクリアするにはCtrl-x (コントロールキーを押しながらx)を押してください。選択した測点のリストをクリアするには、Ctrl-xを二回押してください。
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次も参照して下さい: 拡大と自動スケーリング; 新規X、Y変数の選択; 表示オプションの変更; 印刷; ポストスクリプト・ファイル。

8.1
拡大と自動スケーリング (Zooming and Automatic Scaling)

任意のデータプロットのウィンドウ上にマウスを移動して、右ボタンをクリックしてデータプロット・ポップアップメニューを呼び出し、Full RangeまたはZoomのいずれかを選ぶと、変数の範囲を変えられます。Full Rangeでは、現在のウィンドウのXとYの範囲は、このウィンドウにプロットされた全てのデータに対して最適になるように調整されます。Full Range (All)を使用すれば、画面上の全てのデータプロットを自動スケーリングにできます。
Zoomを選択すると、赤い拡大枠が現在のウィンドウの周囲に現れます。この拡大枠を操作するには、拡大枠の上にマウスを移動して、左ボタンを押し、希望する位置に枠をドラッグしてください。現在の拡大枠の設定を適用して、それに応じて変数の範囲の調整するには、マウスの左ボタンをダブルクリックするかEnterを押して下さい。拡大操作を中止して現在の変数の範囲を維持したいときは、ESCを押すかマウスの右ボタンをクリックして下さい。
これに加えて、最大化を制御する標準的な拡大操作であるquick-zoomオプションも利用可能です。マウスが地図上または任意のデータプロットの上にあるときCtrlキーを押したままにして、マウスの左ボタンを押したまま拡大枠をドラッグしてください。マウスの左ボタンを離すとquick-zoomで操作された拡大枠がウィンドウに適用されます。
8.2
ウィンドウ・レイアウトの変更 (Changing Window Layout)

ODVは、モード毎(STATION, SCATTER, SECTION, SURFACE)に分けてウィンドウ・レイアウト情報を保持します。レイアウト情報には、地図およびデータプロットの位置とサイズ、データプロットの数、X, Y, Z軸の変数、記号のサイズ、地図の地形ファイルの選定が含まれます。これらの各モードでは、背景ポップアップメニューを(背景エリア上で右マウスをクリックして)呼び出し、Graphics Layoutを選択して、各々のウィンドウ・レイアウトを変更できます。ODVは現在のレイアウトの輪郭を描くので、それ対してウィンドウの移動、サイズの変更、削除、作成ができます。ウィンドウ上でこれらの操作の一つを実行するには、そのウィンドウ内にマウスを動かし、右ボタンをクリックしてレイアウト・ポップアップメニュー(layout-popup menu)を呼び出し、適切なオプションを選びます。
Move/Resizeを選択すると、赤い拡大枠が各々のウィンドウの周囲に現れます。この枠上にマウスを動かし、左ボタンを押したままドラッグして、この拡大枠を移動させるか、大きさを変更して下さい。ウィンドウの新しいサイズや位置を適用するには、マウスの左ボタンをダブルクリックするか、ENTERを押して下さい。Move/Resize操作を中止してウィンドウの状態を変更させたくない時はESCを押します。既存のウィンドウをコピーして、そのプロパティを修正すると、新しいウィンドウとして使えます。重ね合わせたウィンドウ(以下を参照)は動かしたりサイズを変えたりできません。

既存ウィンドウの一つの上にマウスを動かして、右ボタンをクリックしCreate New WindowまたはCreate Overlay Windowオプションを選んで新しいウィンドウを作ることができます。両方の場合では、新しいウィンドウの初期のプロパティは既存のウィンドウから引き継がれます。Create New Windowを使うと、重ね合わせたウィンドウが必要とするいくつかのプロパティは自動的に設定され、新しいウィンドウは既存のウィンドウと一列に整列させられます。Window Layoutモードから抜けた後は各々のウィンドウのDisplay Optionsダイアログを呼び出して新しいウィンドウのプロパティを変更できます。

ウィンドウのX, Y, Z軸の新規変数を選択するには、適切なオプションを選択して、表示されるリスト・ボックスの中から変数を選んでください。初期設定の変数の値は右上に増加します。方向を逆にするには(例えば水深図の水深)、Reverse Variable Rangeボックスをチェックして下さい。選択を適用する場合はOKを押します。Graphics Layoutモードの終了はAcceptまたはCancelのいずれかを選択してください。地図やデータプロットのポップアップメニューから表示オプション機能を使用して、それぞれの他のプロパティを変更できます。
8.3
表示オプションの変更 (Changing Display Options)

地図およびデータプロット・ポップアップメニューのDisplay Options機能を使って、地図やデータプロットの表示プロパティを変更できます。これらのメニューの呼び出しは、各々のウィンドウ上にマウスに動かして右ボタンをクリックします。(二つ以上のウィンドウが互いの上に積み上げられている)オーバーレイ・ウィンドウに関して、この方法は最上のウィンドウだけにアクセスします。このような場合はConfiguration>Window Properties>…を使って個々のウィンドウのプロパティを変更してください。
8.3.1
地図(Map)

	“Map Display Options” プロパティ・シートは、General, Layers, Domain, Annotationsの四つのカテゴリーに関する地図プロパティを修正します。これらのカテゴリーにアクセスするには、各々のタブをクリックしてください。
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General
地図に使用されるカラーパレットを選択して背景カラーを選び、グリッド線を描くかどうかを指定して下さい。地図投影法を指定し、測点を示す点の色と記号のサイズを選んで下さい。
Layers

ODVは、地図ウィンドウに海底地形、海岸線、陸上地形の他に、湖沼、河川、境界、流氷の張出し、海洋フロントのような追加情報も描画できます。低解像度の全球地理情報ファイル(GlobLRシリーズ)は、ODV(バージョン4.1以上)をインストールするときに初期設定で提供されます。高解像度の全球および地域データセットはオプショナルパッケージとして利用可能で、いつでもダウンロードしてインストールできます。“Series” リストからインストールしたいシリーズの一つを選んでください。Bathymetry/topography カラーバーを描きたければDraw Color Barボックスをチェックして下さい。
上述の地理情報は、ODVにより個々のレイヤーとして実行されて描画されます。これらのレイヤーは、 (1)pre-Bathymetry, (2)Ocean Bathymetry, (3) pre-Coastlines, (4)Coastlines, (5)pre-Topography, (6)Land Topography, (7)post-Topography.の七つのレイヤーセットにグループ化されます。Layer Setsリストで選択してComposeボタンを押すとレイヤーを構成できます。ODVは、このレイヤーセットを利用可能なレイヤー・リストに表示します。利用可能リストから(標準的なWindows技術を使って)一つ以上のレイヤーを選んで描画特性を指定し、Selected listにレイヤーを追加するには “<<”ボタンを押して下さい。Selected listからレイヤーを削除するには “>>”を押して下さい。
描画特性の指定は以下の規則に従います:
(a) (一筆書の)線で地形の輪郭が描かれる場合は、適切な線の幅、種類、色を選択します。輪郭が不要なら色で “none”を選びます。Windowsの制約のため、1ピクセル幅以上の線は、画面上およびPNGとJPGファイルでは常に一様になりますが、ODV PostScriptファイルならどのような線幅でも、選んだ通りになります。
(b) 地形を塗り潰したければ適切な塗り潰し色を、塗り潰したくなければ “none”を選んで下さい。
線と塗り潰しの色を “automatic”にすると、ODVは初期設定の色を使用します。一部のレイヤーでは“automatic”の初期値が “none”に設定されています。また、河川や境界のような一部の地形ファイルは塗り潰せないので、塗り潰し色は “none”と明示してください。
ODVが地図を描画する時は、上から順にレイヤーセットが処理されます。あるレイヤーセットは、Selected listに表示された順で個々のレイヤーが描画されます(海底地形と陸上地形のレイヤーは、それらが追加された時に自動的に並び替えられます)。“pre-Coastlines”設定で海氷の分布を、“post-Topography”カテゴリーで湖沼、河川、境界を定義してください。
Domain(領域)

緯度経度の副領域を指定するか、コレクションの全領域もしくは全球地図に切り替えます。
Annotations(注釈)

選択された測点が航海および／または測点のラベルを持つかどうかを指定して、ラベルのフォントサイズを設定してください。このオプションは全画面のMAPモードとSTATION モードだけに適用されます(F8 またはF9を押してこれらのモードに切り替えてください)。MAPモードとSTATION モードで測点を選ぶには、マウスの左ボタンをダブルクリックしてください。測点の位置に対するマウスポインタの位置によって、ラベルの位置が決まります。ラベルを測点の位置よりも上に表示させたい時は、測点より少し上を指してダブルクリックして下さい; ラベルを測点の右下に表示させたい時は、右下の位置を同様にダブルクリックして下さい。
8.3.2
データプロット・ウィンドウ (Data-plot windows)
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	成分間プロット(property/property plots) (STATIONモード)では、記号のサイズとデータ点間の結合線の幅を設定してください。記号なし、または結合線なしの場合はゼロを選びます。

	SCATTER, SECTION, SURFACEの各モードでは、表示モード(Original Data: カラードット、数値、または矢印; Quick Gridding; VG Gridding)、オリジナルデータのドット(またはフォント)サイズ、ポイント・サイズ(SCATTERモード)、グリッド領域のXとY方向の平均の長さスケールを設定できます。二種類の異なるグリッド化アルゴリズムが利用可能で、等値線描画はどちらでもサポートされています。また、XとYの長さスケールは、各軸の範囲のパーミル(1/1000)で計測され、大きな値であれば領域は滑らかになります。様々な異なる長さスケールを試してみて、最も好ましいものを選んでください。

流速場の矢符プロットを作成するにはOriginal Dataラジオボタンをクリックして、その真下のコンボボックスからArrowsを選択します。自動的に現れるArrow Properitesダイアログボックス上で矢符のXおよびY成分を選択し、矢符のスケール、線幅、色を指定してください。矢符の色を自動選択すると、矢符に与えられる色はその場所のZ変数に依存します。

軸ラベルを自動作成せずに手動で注釈を記入する場合はAutomatic Axis Labels ボックスのチェックを外してください。Apply to All Windowsボックスをチェックすると、現在のモードの全データプロットに修正が適用されます。データプロットのスタイルを個々に設定したい場合は、このボックスのチェックを外してください。グリッド領域については、Propertiesボタンを使ってオプションの追加と等値線の指定を行ってください(以下を参照)。
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	Propertiesダイアログでは以下のことができます;
· 一般オプションの追加設定
· カラー濃淡のオン／オフの切り替え
· 範囲外の値に関する自動削除のオン／オフの切り替え(計算機への負荷が大きい)

· 等値線の指定
等値線を追加するには、NewグループでStart, Increment, Endを指定します。適切な線のスタイルと色を選んで、Label Size entryを設定し、“<<”ボタンを押すと各々の等値線が追加できます。必要ならば、異なるStart, Increment, End値とできるだけ異なる線のプロパティでこの操作を繰り返してください。ウィンドウあたりの等値線の最大数は50本です。

既存の等値線のプロパティを修正するには、Already Definedリストでそれを選んで、Newグループでプロパティを修正し、“<<”を押して変更してください。


8.4
印刷 (Printing)

現在のODVグラフィクス・ウィンドウの内容を印刷するには、Fileまたは背景ポップアップメニューからPrintを選択してください。
WIN32
ODVはWindows標準の印刷ダイアログを呼び出しますので、システムで利用可能なプリンターを一つ選んでください。OKを押すと印刷が始まります。複雑なグラフィクス画面の印刷にはかなりの時間を要する傾向にあります。PostScriptプリンターにアクセスできるのなら、代わりにPostScriptオプションを使用してください。
UNIX
未だテストされていません。

8.5
ポストスクリプト・ファイル (PostScript Files)

全画面または個々のプロットのPostScriptを作成するには、全グラフィクス・キャンバスまたは個々のプロットのSave Asオプションを選択してください(例えば、背景もしくは各々のプロット上でマウスを右クリックするとSave AsまたはExtrasからSave Single Asを選択できます; あるいは、背景もしくはデータプロット上でCtrl-s (Ctrlキーを押しながらs)を押して、ファイル形式でPostScript (*.eps)を選んでください。

結果として得られたPostScriptファイルをPostScriptプリンターに送ると印刷され、またLaTeX, Word, PageMakerや他のページデザインドキュメントに読み込むこともできます(この機能を利用するにはPortrait orientationで(印刷の向きを縦にして)プロットを保存しなければなりません)。
Printジョブは複雑な断面図や等値面図ではかなりの時間を要する傾向にありますが、PostScriptファイルは中身が詰まっているので印刷は速くなります。初期設定ではPostScriptファイルはODVの一時ファイルディレクトリに書き込まれ、ファイル名は現在の設定ファイル名から名付けられます。その他の名前や保存先ディレクトリは、自動的に表示されるWindowsファイル保存ダイアログを使って選択できます。
8.6
PNGとJPGファイル (PNG and JPG Files)

背景ポップアップメニュー(ODVグラフィクス・キャンバス)からSave Canvas As, またはデータプロット・ポップアップメニュー(個々のプロット)のSave Single Asを選択して、現在のODVグラフィクス画面または個々のデータプロットをPNGまたはJPGファイルへ出力できます(テキストドキュメントに含めるか、あるいは標準的なグラフィックソフトウェアによる後処理には、PNGを使用してください)。ショートカットキーを通じてこれらのオプションに到達できます: (1)マウスが背景領域にあるときにCtrl-s(Ctrlキーを押しながらs)を押すとODVの全グラフィクス・キャンバスのファイルが保存され、(2)データプロット上にマウスがある時にCtrl-sを押すと、各々のデータプロットのファイルが生成されます。ODVはファイル保存ダイアログ・ボックスを表示するので、そこで適切な出力ファイルの形式(PNG(*.PNG)またはJPG(*.JPG))を選択してください。PNGまたはJPGファイルの初期設定名は現在の設定名から名付けられますが、その他の名前または保存先を選択することもできます。

9
散布図(Scatter Plots)

9.1
散布図の作成 (Producing Scatter Plots)

ODVのSCATTERモード (背景ポップアップメニューを使用)に切り替えて、地図上でマウスの左ボタンをダブルクリックすると、現在有効な全測点の成分間プロットが作成できます(オプションとして三番目の変数を使って彩色できます)。
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次を参照してください: 拡大と自動スケーリング; 新規X-Y変数の選択; 表示オプションの変更; 印刷; ポストスクリプト・ファイル。

10
断面図 (Sections)

10.1
断面の定義 (Defining a Section)
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	断面図をプロットするには、先ず背景ポップアップメニューからSection Modeオプションを使ってODVのSECTIONモードに切り替える必要があります。新しい断面を定義するか、以前に定義した断面を使うには、地図上にマウスを置いて右ボタンをクリックし、地図ポップアップメニューを呼び出してください。新しい断面の場合はDefine SectionからDefine Section Spine を選択し、以前に定義した断面を使う場合にはDefine SectionからLoad Sectionを選択します。後者の場合は、リストから断面の一つを(ダブルクリックして)選ぶだけです。新しい断面を作る時のマウス・カーソルは、ユーザーが断面の中心線を定義するための連続点を入力できる状態であることを示す細い十字記号に変わります。細い十字記号を希望する位置に動かしてマウスの左ボタンを押して点を入力していきます。点を消去するには、マウスを点の近くに動かして右ボタンをクリックしてください。点の設定を適用するには、ENTERを押すかマウスの左ボタンをダブルクリックして最後の点を指定します。左図で示されるように、任意の航跡に沿った複雑な断面も作図できます。


断面の中心を指定した後、ODVは断面の帯域に初期設定の幅を割り当て、初期設定の断面に沿った座標の方向に開始点(最初に入力した点)からの距離を選びます。断面特性の初期設定を変更するためにダイアログ・ボックスが表示されます。地図中に印された断面の帯域内にある全測点は断面に属し、後から続くプロット操作でプロットされます。地図ポップアップメニューのDefine SectionからChange Characteristicsを選択すれば、いかなる時でも断面特性を変更できます。この断面を後で再利用するつもりなら、Define SectionからSave Section Asオプションを選択して断面の定義を保存しなければなりません。断面を定義しない場合はDefine SectionからUndefine Sectionを選んでください。
10.2
断面図のプロット (Plotting a Section)

断面の定義を一度すれば、地図上にマウスがあるときに左ボタンをダブルクリックするかpを押すと、断面に沿ったカラーの成分分布図と断面に属する全測点の成分間プロットが描画できます。断面に沿ったカラーの成分分布図の場合は、X軸についてSection Coordinateを選択し、Y軸とZ軸には任意の変数を選びます。
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次を参照してください: 拡大と自動スケーリング; カラーズーミング; カラーマッピング機能の変更; 新規X-Y変数の選択; 表示オプションの変更; グリッド領域の表示; プロット値の出力; 印刷; ポストスクリプト・ファイル。

10.3
カラーズーミング (Color-Zooming)

カラー断面図と等値面上のカラー分布図は、カラーズーミングによってZ変数の範囲を修正できます。カラーズーミングを呼び出すには、修正したい断面図または等値面プロット上にマウスを動かし、右ボタンをクリックしてデータプロット・ポップアップメニューを呼び出してください。ここでZ-Zoomを選ぶと、各ウィンドウのカラーバーの周りに赤い拡大枠が描かれます。前述したように、この拡大枠を操作し、ドラッグして下さい。現在の拡大枠の設定とZ変数の範囲の調整を適用する場合は、マウスの左ボタンをダブルクリックするか、ENTERキーを押して下さい。拡大操作を取り止めて現在の変数の範囲を維持したい時は、ESC キーを押すかマウスの右ボタンをクリックして下さい。
10.4
カラーマッピング機能 (Color Mapping Function)

	カラー断面図と等値面上のカラー分布図に対して、Z変数値のカラーマッピングを操作できます。カラーマッピング機能を呼び出すには、修正したい断面図または等値面図上にマウスを動かし、右ボタンクリックしてデータプロット・ポップアップメニューを表示させてください。ここでColor Mappingを選ぶとカラーマッピングを対話的に変更できます。カラーマッピングを非線形にするには、最高のカラー解像度が得られるZ値にMedianトラックバーを動かし、Nonlinearityトラックバーを使って非線形性を増加させてください。線形のカラーマッピングへ戻すにはLinear Mappingボタンを押します。Value>color mapping functionの変更に加えて、別のカラーパレットも読み込めます。
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10.5
グリッド領域の表示 (Displaying Gridded Fields)

サンプルの位置にカラーの点を表示する代わりに、二つのグリッド化アルゴリズム: Quick GriddingとVG Griddingのいずれかを使用して、Z変数を持つ任意のウィンドウに対してグリッド化した成分の領域を作成できます(例えば、断面に沿った、あるいは等値面上の成分分布図)。Quick Griddingは良好なデータ・カバレッジであれば良い結果を素早く生成できる方法ですが、不十分で不均質なデータ・カバレッジであればVG Griddingの方が適しています(下記参照)。カラー濃淡に加えて、成分領域での等値線描画は両方のグリッド化モードでサポートされています。
「オリジナルのデータ点」モードからグリッド化モードの一つに切り替えるには、修正したいデータプロット上にマウスを移動させて右ボタンをクリックし、データプロット・ポップアップメニューを呼び出します。ここでDisplay Options を選択してQuick Gridding またはVG Gridding のどちらかのボタンをチェックしてからX軸およびY軸のそれぞれに適切な平均の長さスケールを設定します。値は、軸の全範囲のパーミル(1/1000)で表され、値が大きければ平滑化された領域になります。Propertiesボタンを押せば、成分領域に対する等値線の定義や他の成分を設定できます。個々のプロットの表示オプションを修正したい場合は、Apply to All Windowsボックスがチェックされていないことを確認して下さい。ODVの出力に不満があれば、断面図または等値面図のデータを出力して、専用のグリッド化および等値線描画ソフトウェアの使用を検討して下さい。

10.5.1    VGグリッド化アルゴリズム (VG Gridding Algorithm)

等距離で矩形のグリッドに使われるQuick Gridding とは対照的に、 VG Griddingはデータ点の分布を解析して、データ密度にしたがってX軸およびY軸のグリッド間隔が変化する領域では、可変な解像度で矩形のグリッドを構築します。良好なデータ・カバレッジでは高解像度(狭いグリッド間隔)となりますが、サンプルが乏しい領域では、グリッドは粗く解像度は制限されます。例えば典型的な海洋観測の断面に対してこの方法を用いると、外洋域の深層に比べて(データ・カバレッジが通常は良好な)上層の水柱および境界流域では高空間分解能となります。
グリッドの構築後、検討中の成分(水温や塩分など)は、グリッド・ポイントの近傍のデータ値を使用した加重平均法が適用されて全てのグリッド・ポイントで評価されます。重みはグリッド・ポイントからの距離に比例して減少し、ユーザーが指定したX、Y方向の長さスケール(e-folding)で分けられます。ユーザーが指定するX、Yの長さスケールは、各軸の範囲の「パーミル」(1/1000)で計られ、最も乏しいデータ・カバレッジ(最も粗いグリッド)の領域で代表されます。平均の長さスケールはグリッドの間隔に比例します; 例えば、高解像度のグリッド領域(上層の水柱や境界流など)では、短い平均の長さスケールが自動的に使用されます。この総合的な取り組みによって、高密度なデータ範囲における微小スケール構造の特性が解明され、同時に、観測が乏しい海域でも滑らかで安定した領域が得られます。数千ものデータがあっても数秒以内に領域を評価できるように実行速度を上げる特別な方法が実装されています。
最終段階で、評価された領域の値は濃淡と等値線の描画処理に渡され、画面やプリンターに結果が出力されます。
10.6
差分領域 (Difference Fields)

以前に保存した基準データと現在選択している測点の成分分布を比較することができ、成分間の差分を導変数として定義して別の領域を生成できます。ODVの背景メニュー(またはAlt+d(Altキーを押しながらdキー)を押します)からDerived Variablesを選択して、Diff. from Ref を選んでください。Temp\Referenceサブディレクトリから使用したい基準データのExportID.txtファイルを選ぶと、ODVはそのディレクトリから利用可能な基準データファイルのリストを表示します。
Z変数として差分領域を生成する変数と、適切なXおよびY変数(例えば、緯度と水深の断面を生成するには、基準データファイルのXが緯度、Yが深さであることを確認してください)を持つ.oalファイルを選んでください。次に、現在のコレクションのZ, X, Yの各変数を指定して(経度または緯度が必要ならば、Diff. from Ref.を呼び出す前に導変数として定義してください)、差分変数の定義を完了してください。新しい変数の名前は、Z変数の名前と基準データセットの識別文字列(identification string)で構成されています。一度定義すれば、どのデータプロットでも差分変数を使用できます。

11
等値面 (Iso-Surfaces)

11.1
等値面の定義 (Defining Iso-Surfaces)

SURFACEモード(背景ポップアップメニューからSURFACE Modeを選択)に切り替えるか、背景ポップアップメニューからIso-Surface Variablesを選択すると、ODVは現在定義されている等値面の変数のリストを表示するので、新規または既存の等値面変数の編集と削除を行ってください。既存の等値面の変数を削除するには、変数をマウスの左ボタンでダブルクリックをするか、マウスの左ボタンをクリックして変数を選んでからDeleteを押します。新しい等値面の変数を追加するには、まずNewボックスの中で変数を構成してからAddを押して下さい。等値面の変数を構成するには、ある表面に表示したい変数(表示変数)、表面を定義する変数(等値面変数)、そして等値面変数の数値を指定する必要があります。上部または下部の成分分布には、等値面変数としてDepthを選択し、数値の代わりにtopまたはbottomと入力して下さい(最初の文字のtまたはbで十分です)。表示変数または等値面変数に導変数を使いたければ、Iso-Surface Variableダイアログを呼び出す前に定義済み(導数量(Derived Quantities)参照)であることを確認して下さい。
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Already Defined ボックスで等値面変数を選んだら、S-Syncボタン(等値面との同期)をクリックして同じ等値面を使う他の全ての変数と同期します。V-Syncボタン(変数との同期)をクリックすると同じ表示変数を使う他の全ての変数と同期できます。
11.2
等値面分布のプロット (Plotting Surface Distributions)

等値面変数を一度定義すると、マウスが地図上にあるときに左ボタンをダブルクリックするかpを押して、地図上に印される全測点を使った等値面成分間プロットと同様に、等値面上のカラー成分分布図を描画できます。カラープロットではX, Y軸に対して経度、緯度がそれぞれ与えられます。他の全ての集まりでは、成分間プロットが得られます。定義を明示した等値面変数に加えて、時間、年内日、経度、緯度のような追加パラメータは全ての測点に対して記録されていて、成分間プロットで使用できます。
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次を参照してください: 拡大と自動スケーリング; カラーズーミング; カラーマッピング機能の変更; 新規X-Y変数の選択; 表示オプションの変更; グリッド領域の表示; プロット値の出力; 印刷; ポストスクリプト・ファイル。

12
NetCDF対応 (NetCDF Support)

12.1
NetCDFの概要 (NetCDF Overview)

NetCDF (network Common Data Form)は配列指向のデータ保管およびアクセスのためのインターフェイスで、気候研究やその他の地球科学の分野で広く用いられています。多くの重要なデータセットやモデルの出力ファイルがnetCDFフォーマットによって研究者間で配布され共有されています。
12.1.1
NetCDFとは (NetCDF data is)
· 自己記述方式です。netCDFファイルは包含データの関する情報を含んでいます。
· アーキテクチャに依存しません。 netCDFファイルは、整数、文字列、浮動小数点の記憶方式が異なるコンピュータでもアクセスできる形式で表されています。
· ダイレクト・アクセスが可能です。最初に全てのデータを読み取らなくても、大きなデータセットの一部分に効率よくアクセスできます。
· 追加が容易です(Appendable)。データセットをコピーまたはその構造を再定義しなくても、データを一次元でnetCDFデータセットに追加できます。時々データセットがコピーされることになりますが、netCDFデータセットの構造は変更可能です。
· 共有性(Sharable)があります。同じnetCDFファイルに対して同時に、一人のユーザーが書き込んで複数のユーザーが読み取れます。 

12.1.2
NetCDF協定 (NetCDF conventions)
NetCDFデータモデルは非常に一般的で、netCDFの構造や内容を大幅に変えられます。NetCDFデータセットの相互交換および共有を容易にして促進するために、いくつかの協定が決められています。これらの協定のうち二つ(COARDSおよびGDT; 仕様は

http://www.unidata.ucar.edu/packages/netcdf/conventions.html
を参照)は、気候研究者やモデル研究者が広く使っており、非常に多くの重要なデータセットがCOARDS/GDT netCDFファイルとして利用可能です。このようなデータセットは、例えば次のサイトからダウンロードが可能です:

http://www.cdc.noaa.gov/PublicData/, http://ferret.wrc.noaa.gov/, http://ingrid.ldeo.columbia.edu/, http://www.epic.noaa.gov/epic/ewb/.

より詳細なnetCDFの情報は、netCDF webページをご覧ください:

http://www.unidata.ucar.edu/packages/netcdf/.
12.1.3
ODV のnetCDF対応 (ODV netCDF support)
ODVはODVコレクションと同様にnetCDFファイルのデータを読み込んで可視化します。NetCDFファイルで作業しているときもODVの全機能が利用可能です。ただし、netCDFファイルへの書き込み許可が必要なときと、データセットを修正するときは例外です(ODVはnetCDFファイルに書き込むことができません)。NetCDFファイルが COARDSとGDTのnetCDF慣例に従っていれば、ODVは多くの変数を解釈することができます。例えば、絶対的または相対的な時間のフォーマット、欠測値の指示子のような変数の属性の識別、長い変数名、単位などです。ODVは、非常に大きなデータセットで作業している時にしばしば必要となるデータの副設定が可能です。
12.2
NetCDFファイルの使用 (Using netCDF Files)

ODVは、地球科学の様々な分野の研究者によって広く使われているnetCDFファイルのデータの読み取りと可視化ができます。ユーザーによるわずかな設定や選択に基づいて、ODVは本来のODVコレクションをエミュレート(模倣)する方法で、netCDFファイルにアクセスして解釈します。ODVの解析および可視化の全機能がnetCDFファイルのデータの調査に利用できます。最初にデータを変換してから再度読み込む必要はありません。NetCDFファイルの構造または内容によっては、別々のODVエミュレーションが可能です。個々のエミュレーションの設定は、後で使用できるようにディスク上に保存することができます。NetCDFファイルはプラットフォーム(訳注: コンピュータの種類)に依存しないので、同じファイルをWindowsまたはSolaris上のODVで使用できます。
(1) netCDFファイルを開く(Opening a netCDF file)

File>Open netCDF Fileの順に選択すると、ODVでnetCDFファイルを開くことができます。標準のWindowsファイル選択ダイアログを使って、開きたいファイルを指定してください。または、コマンド行の引数にnetCDFファイル名を指定して、コマンド行からODVを起動できます。Windowsなら、ODVデスクトップ・アイコンにnetCDFファイルをドラッグすることもできます。いずれの場合も、netCDFファイルの拡張子は.ncまたは.cdfでなければなりません。ODVはnetCDFファイルを開いて、ファイルに含まれている次元や変数に関する情報を検索します。
(2) netCDFエミュレーションの定義 (Defining the netCDF emulation)

一連のステップにおいて、ODVがどのようにしてnetCDFファイルを閲覧(またはエミュレート)するのかを定義する必要があります。これには、座標軸(次元)の選択と(もし必要なら)副設定、netCDFファイルからの情報に基づくODVヘッダー変数との関連付け、「測点」(例えばプロファイルや連続観測など)の論理的な構造を決めて測点内で並び替えるための一番目の変数(ODVコレクションの第一変数)の定義が含まれます。
最初にODVは、新しくエミュレーションを定義するか、または既に定義されて保存されているエミュレーションを使うのかを尋ねてきます。既に定義されたエミュレーションを選ぶと追加入力の必要はなく、ODVは本来のODVコレクションと同様に処理します: 測点図が描画され、ODVの解析および可視化に関する全機能が利用できます。ODVは開いたnetCDFファイルを読み取り専用のデータセットとして扱うので、修正ができません。したがって、データを書き込む操作が求められる全ての機能(データの読み込み、ヘッダーおよびデータの編集、コレクションの取り扱い操作など)は、netCDFファイルでの作業中は利用できません。
(2.a) netCDF座標の副設定および選択 (Subsetting and selecting netCDF coordinates)

新しくエミュレーションを定義する時に最初に行う作業は、netCDFの座標の副設定と選択です。ODVは、ファイルに含まれている次元／座標のリストを、それらの長さと現在使用されているインデックスとともに表示します(Dimensions リストに表示されます; インデックスは0から始まり、インデックス・セットは「開始インデックス: 間隔(stride): 終了インデックス」で定義されます; 初期のインデックスは全てインデックスです)。
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副設定 (Subsetting)

非常に大きいnetCDFファイルの場合は特に、興味のある範囲にアクセスするデータの制限、または解析から他のデータを除外する必要がしばしばあります。例えば、何ヵ月ものデータを含んでいるファイルの中で、数ヵ月または一月分だけに興味がある場合は、時間軸の副設定が必要となります。多くの観測層を含んでいるファイルの中から、ある特定の水深だけを解析したいような場合は、解析を行う前に深さの次元を設定してください。
特に次元／座標を設定する場合には、Dimensionsリストの中から項目を選んで、Subset Dimension ボタンを押してください(このボタンを有効にするには、次元がリストの中で唯一の選択でなければなりません)。ODVは全ての座標値のリストを表示しますので、使用するインデックス・セットのstart index, stride(間隔)、end indexを指定してください。単独のインデックスを選ぶには、start indexおよびend indexのフィールドと同じインデックス値を入力します。この新しいインデックスを適用するにはOK を押して下さい。設定したい全ての次元／座標に対してこの手順を繰り返してください。

選択 (Selection)

次に、この後の関連付けられた変数の解析に使いたい全ての次元／座標を選択しなければなりません。拡張選択技術(CtrlまたはShiftキーを押したままマウスの左ボタンをクリックする)を使って複数選択を行ってください。多次元で共通の座標であるX(経度)、Y(緯度)、Z(水深／高度)、T(時間)を使う場合は、各方向につき一つだけ選択して下さい。
ある次元を選択すると、これらの次元上で定義されているnetCDF変数セットがCorresponding Variablesリストに表示されます。興味のある変数がこのリストに表示されているかどうか確認して下さい。Dimensionリストで選択されなかった座標に依存するnetCDFファイルの他の変数は、Corresponding Variablesには表示されず、対応する次元を選ばない限り、それらの変数は利用できません。NetCDFファイルの完全なヘッダー情報を閲覧するには(“ncdump -h”に相当)、netCDF Infoを押してください。
(2.b) ヘッダー情報の明示 (Specifying header information)

次に、ODV測点にヘッダー(またはメタ)情報を与えるnetCDF変数を特定しなければなりません: 例えば、経度(Lon(°E))、緯度(Lat(°N))、日付(mon/day/yr)など。これは、netCDFファイルの変数(Source Variablesリスト)と標準ODVヘッダー変数(Target Variables リスト)と間で関連付けによって行われます。最初にODVは自動的に変数の識別と関連付けを試みます。手動による変数の関連付けは、一桁目のカラムに*が付いていないヘッダー変数に関してだけ必要となります。通常は経度(Lon(°E))、緯度(Lat(°N))、日付(mon/day/yr)の関連付けだけで十分です。どのnetCDF変数にも関連付けられないヘッダー変数に対しては初期設定の値が使われます。ヘッダー変数の初期値(例えば航海名など)を修正するには、Target Variablesの中からそれを選び、 Set Defaultを押してください。

NetCDF変数とODVヘッダー変数との間で(一対一)の関連付けを行うには、Source Variablesリストの中からnetCDF変数を、Target Variableリストの中からヘッダー変数を選んでAssociateを押してください。NetCDFとODVヘッダー変数との間で変換を行うには(通常はnetCDFの時間変数に必要)、上述した二つの変数を選んでからConvertを押します。コンボボックスから利用可能な変換オプションを一つ選んで、OKを押してください。 General Linear Transformationにはスケール係数とオフセットを与えます。
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多くのnetCDFファイルでは、特定の開始日付からの日数や時間といった相対的な時間を使用します。測点の日付と時刻を得るにはこの情報が利用できます。そうするには、Source Variablesリストから相対時間を、Target Variablesから日付(mon/day/yr)を選んでから、Convertを押してください。ODVは自動的に変換関数の確立を試みますが、手動で適切な変換アルゴリズムも選択できます。ODVは基準日付がグレゴリオ暦に基づいていると仮定します。ODVの日付(mon/day/yr)の値は、グレゴリオ暦の日付です。
ヘッダー変数のStation とType は自動的にODVで設定されます。

(2.c) 基本座標の選択 (Selecting primary coordinate)

最後に、コレクションの第一変数として後でODVが使用する基本座標を選択する必要があります。この変数はstation/profile/sequenceの変数の並び替えにも使われます。ODVが測点として取り扱う論理構造を確定するので、基本座標の明示は重要です。例えば、基本座標として「水深」または他の鉛直座標を使用すれば、測点は鉛直プロファイルを表します; 時間を使用すれば、測点は時系列で表されます。日付(mon/day/yr)ヘッダー変数が上記(2.b)で定義されていれば、Use Decimal Date/Timeの項目が使用可能になり、基本座標として測点ヘッダーから導かれる十進数の時間変数(単位＝年)が使用できます(時系列に関しては、日付(mon/day/yr)ヘッダー情報は時系列の開始を定数として参照します)。
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NetCDFファイルのデータが水平面上の値(例とえば、大気－海洋境界面を横切るフラックスなど)を表しているが、各々の表面を明らかに特定するnetCDF変数がない(例えば、鉛直座標がない))場合は、Use Dummy Variable項目を選択して、ダミー変数のラベルと単位(例えばDepth [m])、および表面の定義に関連付けられた数値(例えば海面には0)を指定します。

(3) netCDFファイルの探究 (Exploring the netCDF file)

一度(2.a)から(2.c)までのステップが完了すると、ODVはnetCDFファイルからデータを読み始めます。ODVは測点図を描き、ODVの解析および可視化の全機能分析・表示機能を使用できます。ODVはnetCDFファイルには書き込まずに読み込み専用のデータセットとして扱います。したがって、データを書き込む操作が求められる全ての機能(データの読み込み、ヘッダーおよびデータの編集、コレクションの取り扱い操作など)は、netCDFファイルでの作業中は利用できません。
また、netCDFファイルからのデータアクセスは、本来のODVコレクションに比べると遅くなります。何万もの(エミュレートされた)測点を含む大きなnetCDFデータセットを使ってSCATTER(散布図)またはSURFACE(等値面図)の作成が遅く感じる場合は、(上述の)次元の副設定を検討するか、ExportのODV Collectionを使って本来のODVコレクションにnetCDFデータを出力してから解析と可視化にこの新規作成したコレクションを使用してください。
鉛直断面図を作成するには、SECTIONモードに切り替えてください。例えばConfiguration>Use Template>SECTION 2 Winの順に選択してから、地図ポップアップメニューのDefine Section>Define Section Spineを使用して選択する断面を定義します。水平面上あるいは他の緯度／経度の等値面上の成分分布を描画するには、例えばConfiguration>Use Template>SURFACE 1 Winの順に選んでSURFACEモードに切り替えてください。それからConfiguration>Iso-Surface Variablesによって等値面変数を定義し、プロット・ウィンドウ上のZ変数としてそれらを使用します。
現在の設定を保存するとき、上述の(2.a)から(2.c)までのステップで指定したnetCDFエミュレーションの設定は、後で利用するために.nceファイルに保存されます。
13
コレクションの操作 (Manipulating Collections)

13.1
コレクション変数セットの変更(Changing the Set of Collection Variables)

新しいデータが、与えられたデータコレクションに未だ含まれていない変数によって利用可能になる時には、これらの変数をコレクションに追加しなければなりません。また、時にはいくつかの既存の変数をコレクションから削除しなければならないでしょう。
	コレクション変数を追加および／または削除するには、コレクションを開いて、メインメニューから Collection>Add/Delete Variablesの順に選択してください。新しい変数を追加するには、(括弧[]で括る単位も含めて)変数ラベルをNew Variableコントロールに入力してからAddを押します。変数を削除するには、Defined Variablesリストから変数を選択して、Deleteを押してください。変数の並びを変更するには、変数を一つ選んでUpまたはDownで動かします。実行する場合はOKを押して下さい。全コレクションは書き直されなければならず、大きなデータコレクションであればある程度の時間がかかります。
	[image: image34.png]Define Variables for NewCol

New Vaiable

21x

Add

Defied Variales
Depth [m]

Temperature ['T]

Salniy [pl U

Fhosphate [~§m~Hmoi]
Silcate [~$m~Himol] Down
Nitate [“$mfmol]
Nitie [~$m~tmol1]
pHI

Chlorophyl [“$m~Ha/]
Plarkton/Biomass [ Delete
Akt [mea/]

Edt

o =







13.2
並べ替えと圧縮 (Sorting and Condensing)

ODVの測点検索および選択アルゴリズムは、コレクション内の測点がある特定の方法で並び替えられている時に最も効率よく機能します。したがって、多くの測点の読み込み、入れ替え、結合、削除の後には、コレクションを並べ替えて圧縮することを推奨します。並べ替えと圧縮処理の呼び出すには、ODVのメインメニューからCollection>Sort and Condenseの順に選択します。

13.3
選択済み測点サブセットの削除(Deleting Selected Station-Subset)

ODVのメインメニューからCollection>Delete Station Subsetの順に選択すると、現在選択されている測点をコレクションから削除できます。現在の測点だけの削除であれば、Collection>Delete Current Stationを選んで下さい。コレクションのディスク・ファイル中の削除された測点のデータ空間は、コレクションの並べ替えと圧縮を行わない限り解放されません。
14
ユーティリティ (Utilities)

14.1
データインベントリ・テーブル (Data Inventory Tables)

ODVのメインメニューからUtilities>Inventory Table fromの順に選ぶと、現在開いているコレクションのインベントリ・テーブルを作成できます。出力ファイルは単純なアスキーファイルで、コレクションのディレクトリに書き出されます(拡張子は.inv)。
14.2
時系列データ分布図 (Temporal Data Distribution Plots)

ODVのメインメニューからUtilities>Temporal Distributionの順に選ぶと、現在選択されている測点の(月および年の)時系列分布図を描画できます。
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14.3
データ検索 (Data Retrieval)

ODVは、経度/緯度/水深(Lon/Lat/Depth)の間隔で定義された範囲における全てのオリジナルデータ点を使って、選んだ変数の平均値および標準偏差を計算して出力することができます。現在の選択基準を満たして、地図上に表示されている測点だけが検索の対象となります。検索の呼び出しに先立って適切な測点選択基準を適用すると、異なる年、月、季節毎の平均値が得られます。データ検索オプションを選ぶには、ODVのメインメニューからUtilities>Data Retrievalの順に選ぶと、データ検索オプションを選択できます。ODVは、検索ボックスのジオメトリ情報を含む検索入力ファイル(拡張子.rtv)と、出力する変数の数を促します。“.rtv”ファイルは検索オプションの呼び出しに先立って用意されていなければなりません。
“.rtv” ファイルのフォーマットは次の通りです:
· 単純なアスキーファイルで、一行につき一つのボックス／変数が定義され、(一つ以上の)スペースで区切られる七つの数字で、
· 数字の意味は: 経度 緯度 水深 (ボックス中央の)経度 緯度 水深 変数の数。
一度.rtvファイルを指定したら、ODVは作業を開始します。平均する際に、ODVは範囲外のデータをチェックし、平均値から標準偏差の三倍以内のデータだけを使います。出力は.rtvファイルと同じ名前で拡張子が.outのファイルに書き出されます。
出力ファイル.outのフォーマットは次の通りです:
· 単純なアスキーファイルで、.rtv ファイル中の一行につき一行の出力ライン、タブ区切りの11個の値、
· 値の意味: lon lat dep variable# (.rtvファイルと同じ)alon alat adep aval+-sdev nu nr.
alon, alat, adep, ava はそれぞれ平均の経度、緯度、水深、使用されたデータの変数値を、sdevは個々の変数値の標準偏差を表します。nuは使用されたデータ点の数、nrは除外したデータ点の数です。各々の検索ボックスについて、全ての個々のデータ値は、ODVの一時ファイルディレクトリ(通常はc:\Program Files\Ocean Data View (mp)\Temp)のアスキーファイルODVrtv?.datに出力されます。“.dat”ファイル中の値の意味は次の通りです: 番号 経度 緯度 水深 年内の経過日値 重み 使用／除外フラグ。
14.4
地衡流 (Geostrophic Flows)

SECTIONモードで、ODVはUtilities>Geostrophic Flowsオプションで地衡流速を計算して可視化します。水深面あるいは他の基本または導変数(例えば、ポテンシャル密度など)の等値面を選択して基準層を定義し、結果を受け取る.o4x出力ファイルの名前を指定してください。初期設定では、このファイルはコレクションのディレクトリの‘GeoVel’サブディレクトリ (このサブディレクトリがなければ自動的に作成されます)に書き出されます。ODVが計算を始めると、上記で指定した.o4xファイルにペアとなる測点の結果と地衡流速を出力します。
一旦完了したら、新規に計算したペアの断面と速度データに関する新しいODVセッションの呼び出しが可能になります。‘Yes’をクリックすると、新しいODVセッションはGeoVel ディレクトリに新しいコレクションを作成し、書き出されたばかりの.o4xファイルを自動的に読み込みます。それから標準的なODVの手順に従って、地図を拡大して適切な地図領域を定義し、F11キーを押してSECTIONモードに切り替えて、一つ以上のプロット・ウィンドウのZ変数としてGeostr. Vel. [cm/s], Geostr. Vel. (north comp.) [cm/s], Geostr. Vel. (east comp.) [cm/s]を定義してください。与えられた測点のペアの測点ラベルA->B: alphaは、ペアに用いた測点のオリジナル測点番号AとB、Geostr. Vel. [cm/s] の正の値を持つ流れの方角alpha (alpha=0: 東向き; alpha=90: 北向き; など) で構成されています。
地衡流速は、二点の海洋観測間における力学的高度の差から計算されます。一般的に、二つの測点の観測深度は一致しないので、最初のステップで、観測値を共通の深度に配置し直します(ODVは定義済みの標準層へ内挿するために、区間線形の最小自乗法を使います)。それから、標準層での力学的高度が両測点で計算され、力学的高度の差から(標準層における)測点間の地衡流速が得られます。ODVはコレクションの全変数の平均値(二点間の平均)も計算します。二点平均と地衡流速の両者は、二測点間の中間の値を表しており、ODVはペアである二測点間の中間点における「仮想」ペア測点としてこれらの値を.o4x出力ファイルに書き出します(ペア測点の測点ラベルはオリジナル測点の測点ラベルを含んでいます)。
赤道の近く、または粗い海洋観測の測点について地衡流速は計算されません。結果はデータエラーに非常に敏感ですので、Utilities>Geostrophic Flowsオプションの呼び出しに先立って、断面の水温および塩分データの品質管理を慎重に行って下さい。処理方法の一つは、データ編集を使って “Questionable”または “Bad”のような疑わしいデータにフラグを付加して、(適切な選択基準を適用した) “Good”データだけを表示と計算に使うことです。適切な測点選択基準を適用することで、ある調査に関する測点だけが計算に含まれていないか、または断面帯の内部にある他の航海の測点が除外されているか確認できます(断面帯を横切る他の海洋観測線に注意してください)。
14.5
基準データセット (Reference Datasets)

現在のプロット・ウィンドウのオリジナルデータをアスキーファイルに保存して、メインメニューから Utilities>Define as Referenceの順に選択して、これらのデータを基準データセットとして後で使用できます。基準データ(txtID)を識別する説明文を入力してOKをクリックしてください。ODVはReference\txtIDという名前のサブディレクトリをODVのローカル・ディレクトリ(通常<home>\odv_local)に作成して、このディレクトリに全てのファイルを書き出します。すでに存在していれば、ODVは作業を継続する前にこのディレクトリから全ファイルを削除するための許可を問い合わせてきます。基準データは、差分変数を定義するときにODVが使用します。
14.6
範囲外の値の検索 (Finding Outliers)

Utilities>Find Outliersオプションを選択すると、指定された範囲外のデータ値を持つサンプルを現在選択されている測点から走査できます。変数リストから走査する変数を選び、範囲の最小値および最大値を入力してください。 OKを押すと走査が始まります。ODVは見つかった範囲外の値の数を知らせてきますので、範囲外の値のリストを見て、範囲外のデータ値または品質フラグを検査したり修正したりしてください。
Inspect and Edit Outliersをチェックすると、ODVは認識した全ての範囲外の値を見て回り、各々の値を削除するか、 “Questionable”または “Bad”として印をつけるかどうか問い合わせてきます。Apply to Allを押すとODVは選択された全ての範囲外の値に適用しますが、そうでなければユーザーは個々の範囲外の値に対する操作を促されます。各々の範囲外の値はデータプロット中で印が付けられます。
14.7
重複測点の検出 (Finding Redundant Stations)

Utilities>Find Redundant Stationsを選択すると、占有地内で同一または近傍の位置と時間を持つ測点(重複測点)をコレクションから走査できます。重複測点のリストはディスクに書き出されます(初期設定名はredundant.lst)。“redundant.lst”ファイルでは、重複測点のセットが空白行で区切られています。各測点には次の情報が与えられます: (1) internal no.(内部番号), (2) cruise label (航海ラベル), (3) station label (測点ラベル), (4) station type (測点の型), (5) date (日付)、(6) longitude (経度), (7) latitude (緯度), (8) no. of observed levels (観測層数), (9) deepest level (最深観測層), (10)基本変数2～nvarの有効率を示す指示子(例えば7は、ある変数に関して70から79％までの観測層のデータが含まれていることを意味します)。重複測点を削除するには、地図ポップアップメニューのSelect Station by Nameを使って現在の測点にしてから、Actions>Delete Current Stationを使って削除します。
大きなコレクションでは、重複測点の走査にかなりの時間を要します。

15
グラフィクス・オブジェクト (Graphics Objects)

ODVのグラフィクス出力を改良できます; テキストを追加したり、データ点を強調したり、線や他の幾何学的なオブジェクトを追加して、専門的な仕上がりが得られます。ODVのグラフィクス・オブジェクトは(1)注釈(text annotations)、(2)直線(straight lines)、(3)四角形(rectangles and squares)、(4)楕円および円(ellipses and circles)、(5)結合線(polylines)(直線のセグメントもしくはベジエ曲線(straight-line segments or Bezier smoothed))、(6)塗り潰し多角形(filled polygons)(直線のセグメントもしくはベジエ曲線)、(7)シンボル(symbols)、(8) シンボルセット(symbol sets)、(9)凡例(legends)を含んでいます。
作成(Creation)

自動的に作成される凡例を除いて、地図またはデータプロット・ポップアップメニューからExtras>Add Graphics Object>... (ここで...は、作りたいオブジェクトの種類を表す)の順に選択するか、あるいは背景ポップアップメニューからAdd Graphics Object>...の順に選択して、その他のグラフィックス・オブジェクトを作成して追加できます。作成後には、オブジェクトの様々なプロパティを定義するためのダイアログ・ボックスが表示されます。これらのプロパティはいつでも変更が可能です(下記の編集と削除(Edit and Delete)を参照してください)。グラフィクス・オブジェクトは、作成を始めたときのウィンドウ(または背景領域)の所有となり、グラフィクス・オブジェクトの座標は、各ウィンドウの座標系に記録されます。その結果、各ウィンドウを移動したりサイズを変更したりすると、ウィンドウの全てのオブジェクトも自動的に追従します。
編集と削除(Edit and Delete)

オブジェクト(シンボルセットの場合はどれか一つ)の上にマウス動かして右ボタンをクリックし、ポップアップメニューからEdit Objectを選んで、そのオブジェクトのプロパティを修正できます。ダイアログ・ボックス(別のオブジェクトには別の)が現れますので、簡単かつ素早くプロパティを変更できます。いかなるグラフィクス・オブジェクトも、その親ウィンドウに切り抜かれるので(clip to windowボックスをチェック)、ウィンドウにデータが描かれる前にそれを描くようにもできます(pre-data plotボックスをチェック)。マウスをオブジェクト上に動かしてマウスの右ボタンをクリックし、Delete Objectを選択して、そのオブジェクトを削除できます。
ドラッグ(Dragging)

グラフィクス・オブジェクトの属性allow draggingが設定されていると、異なる位置にドラッグするだけでそのオブジェクトを再配置できます。オブジェクトをドラッグするには、そのオブジェクト上にマウスを動かし、左ボタンを押したままマウスを動かして下さい。初期設定では、データ値にリンクされたシンボルセットを除いた他の全てのグラフィクス・オブジェクトに対して、ドラッグが有効になっています。“allow dragging”属性は、Editダイアログ(上記参照)を使っていつでも変更できます。
15.1
注釈 (Annotations)

ODVのグラフィクス・ウィンドウに注釈を追加するには、背景、地図、またはデータプロット・ポップアップメニューから(Extras>)Add Graphics Object>Annotationの順に選択してください。細い十字記号のカーソルが現れますので、注釈を表示したい位置にそれを動かして、マウスの左ボタンをクリックします。個々のオブジェクトは、作成を始めたときのウィンドウの所有になります。注釈を追加(または編集)する際に、注釈文の位置、方向(度、反時計回り)、フォントサイズ(ポイント)、色、配置パラメータを設定してください。注釈は枠を持つことができ、注釈を描く前に注釈の矩形枠を塗り潰せます。これらの全項目に対して別々の色を選べます。注釈文の最大の文字数は255文字です。特殊文字の効果として、文中に次の制御文字列が使えます:
~$
記号フォント(ギリシャ文字)へ切り替える
~#
通常のテキスト・フォントへ切り替える
~%
パーミル記号を生成する
~^
次の文字を上付きにする
~_
次の文字を下付きにする
他の全てのグラフィクス・オブジェクトと同様に、マウス・カーソルを注釈の上に移動させて、マウスの左ボタンを押しながら動かすと、注釈を別の場所にドラッグできます。マウスを注釈の上に移動させて、マウスの右ボタンをクリックして、ポップアップメニューからEdit Objectを選択すると注釈を編集できます。注釈(全注釈)を削除するには、ポップアップメニューからDelete Object(Delete All Objects)を選択してください。

データプロット・ウィンドウの軸ラベルは(自動)注釈として実装されています。それらはプロット・ウィンドウが描かれると自動的に作成され、各データプロット・ウィンドウが削除されると削除されます。軸ラベルをドラッグ、編集、削除することはできますが、プロット・ウィンドウが再描画されると自動作成版が再表示されてしまいます。軸ラベルを「永久に(permanently)」に変更したい場合は、背景ポップアップメニューからExtras>Add Graphics Object>Annotationの順に選択して、手動で注釈を作成してください。新しい注釈を定義した後で設定の保存を確認し、印刷またはPostScriptファイルに書き出す前に自動作成された軸の注釈を削除して下さい。
15.2
線および多角形 (Lines and Polygons)

地図、データプロット、または背景に直線(straight lines)、結合線(polylines)、または多角形(polygons)を追加するには、データプロットまたは背景ポップアップメニューの(Extras>)Add Graphics Object>Line>PolylineまたはPolygonを選択してください。三つのケースともにカーソルが細い十字記号に変わりますので、オブジェクトの節点を指定してください。「直線」では始点と終点を定義しなければなりません: 十字記号を直線の始点に動かしてマウスの左ボタンをクリックし、それから終点に動かして、再度左ボタンをクリックして下さい。結合線または多角形では、最大1000点まで定義できます。多角形はODVによって自動的に閉じられます。節点を削除するときには、十字記号をその近くに移動させてからマウスの右ボタンをクリックします。ENTERを押すと、多角形または結合線の点の定義が終わります。
直線、結合線または多角形の節点を一度指定すると、ODVは(結合)線の色、幅と種類、多角形の塗り潰し色(直線と結合線では無視されます; 多角形の塗り潰しを避けるには塗り潰し色を “none”としてください)を設定するダイアログ・ボックスが現れます。1ピクセルより広い線は、多くの画面やプリンタ・デバイスでは一様な濃さになります。しかしながら、ODV PostScriptファイルでは常に要求された線の種類となります。結合線と多角形でBezier smoothingボックスをチェックすると滑らかになります。

15.3
矩形および楕円 (Rectangles and Ellipses)

地図、データプロットまたは背景ポップアップメニューの(Extras>)Add Graphics Object>RectangleまたはEllipseを選択すると、地図、データプロットまたは背景上に矩形(正方形)と楕円(円)を追加できます。新しい矩形または楕円の境界ボックスを示す赤い拡大枠の矩形が現れます。拡大枠の矩形は移動またはサイズの変更が可能です。ENTERを押して設定を適用します。ダイアログ・ボックスが現れますので、矩形または楕円のプロパティを定義して下さい(詳細は線および多角形(Lines and Polygons)参照して下さい)。
15.4
記号 (Symbols)

記号(点、正方形、ダイヤモンド、三角形、逆三角形、星、十字線、プラス)を、地図、データプロット、または背景に追加するには、地図、データプロットまたは背景ポップアップメニューから(Extras>)Add Graphics Object>Symbolの順に選択します。十字記号が現れますので、記号を表示させたい場所へ移動させて、マウスの左ボタンをクリックして下さい。Symbol Propertiesダイアログ・ボックスが現れたら様々な記号のプロパティを設定してください。

15.5
記号セットと凡例 (Symbol Sets and Legends)

選択したデータ点に記号(記号セット)を割り当てて、プロット・ウィンドウ上のデータ点のサブセット、または地図上の測点のサブセットを強調表示できます。データ・ウィンドウや地図に記号セットを作成するには、このウィンドウ上にマウスを動かして、Extras>Add Graphics Object>Symbol Setの順に選択してください。記号セット選択ダイアログ・ボックスが現れたら、データ点のサブセットを選択します(航海ラベル、測点および／または個々のサンプルを指定します)。選択リストに点を追加するには “<<”ボタンを押して下さい。全ての要望された点が選択されてからOKを押すと、記号セット・プロパティ・ダイアログ・ボックスが現れますので、記号の特性を定義してください。記号セットが持つ説明文(凡例)は、各々のウィンドウの凡例に自動的に追加されます(add to legendsボックスをチェックしてください)。他のグラフィクス・オブジェクトとは異なり、記号セットは選択されたデータ点に関連付けられているので、ドラッグできません。記号セットのいずれか一つの上にマウスを動かして右ボタンをクリックし、Edit Graphics Objectを選択すると、いつでも記号セットの全プロパティを変更できます。
データ・ウィンドウまたは地図で、add to legendsオプションが有効になっている記号セットを含んでいれば、このウィンドウに関する全ての記号セットの記号と凡例文を含む凡例ボックスが現れます。凡例セットは別の場所にドラッグできて、それらのプロパティ(凡例ボックスの大きさは、凡例文のフォントサイズを変えると修正されます)はいつでも修正できます(マウスを凡例セット上に移動させて右ボタンをクリックし、Edit Graphics Objectを選択してください)。
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16
その他 (More …)

16.1
海底地形の地名索引 (Gazetteer of Undersea Features)

ODVは海山、海嶺、断裂帯、トラフ、海盆といった海底地形を識別できます。地名索引オプションを呼び出すには、地図ポップアップメニューからExtras>Gazetteerの順に選択してください(または地図上にマウスがあるときにCtrl-g(Ctrlキーを押しながらg)を押してください)。地名索引ダイアログ・ボックスが表示されますので、特定のデータベースを選択し、地形選択基準と同様に、ODVが描く地形索引の印のサイズと色を指定してください。 OKを押すと、選択した地名索引データベースから情報が読み込まれ、地図上の地形の位置に印が付けられます。マウスを地形の印の近くに動かすと、地名を表示するポップアップ・ウィンドウが呼び出されます。地名索引の印を無効にするには、地名索引ダイアログ・ボックスを再び呼び出して、Databaseリストでnoneを選択してください。
ODVでは三つの地名索引ファイル: (1)国際水路局(IHB)によるGazetteerGEBCO.gzt, (2)米国防衛地図庁によるGazetteerBGN.gzt, (3)WOCE海洋観測プログラムで実施されたセクションを集めたWHP_Sections.gztを提供しています。 “gazetteer”ダイアログ・ボックスを使って、地形の種類および／または地形名の一部を指定したサブセットを作成できます。名前とタイプの選択は大文字と小文字を区別します。地名索引文字列は設定ファイルに保存できません。コレクションを開いたときには必ず地名索引オプションは無効になるので、使うときには有効にしなければなりません。

地名索引ファイルは編集と拡張が可能です。ユーザー独自の新しい地名索引データベースを作ることもできます。ODVで個人的な地名索引を使うためには、そのファイルの拡張子を.gztとして、ODV地名索引ディレクトリ(通常はc:\Program Files\Ocean Data View (mp)\include\gazetteers)に置いて、そのフォーマットは以下に示す仕様を満たしていなければなりません:

ファイルの最初の行は% GZT01:で始まり、この後にファイルの名が続きます。
続いて%で始まって任意のコメントを含む七行があります。
その次の行は: Feature;Type;No;East-Longitude;North-Latitudeでなければならず、一つの空行があとに続きます。
残りは実際の項目の定義が含まれています。一行につき一つの地名が記録されています。
地形名、その種類、緯度経度の点数、経度／緯度の記載はセミコロン “;”で区切られています。経度は東向きに度の単位(0-360)で指定されます。緯度経度の点数は1500まで、一行の長さは200,000文字までです。
16.2
ドラッグ&ドロップ (Drag-and-Drop)

ほとんどのプラットフォーム(訳注:コンピュータの種類)でODVウィンドウまたはアイコン上にODVがサポートするファイルをドラッグ&ドロップできます。ドラッグされたファイルの拡張子に依存してODVは以下に続く動作を実行します:

.var:
現在のコレクションを閉じて、ドロップされたファイルを開きます。

.ncまたは.cdt:
現在のnetCDFファイルを閉じてドロップされたnetCDFファイルを開きます。
.txt (ODVスプレッドシートファイル),

.o4x (ODVリストファイル),

.csv (WOCE WHP交換ファイル),

.jos (Java Ocean Atlasスプレッドシート):


現在開いているコレクションにドロップしたファイルからデータを読み込みます。コレクションがなければファイルをドロップしたときに、ODVはドロップしたファイルと同じディレクトリに新しいコレクションを作り、この新規作成されたコレクションにデータを読み込みます。

全てのプラットフォーム上で、ODVがサポートするファイル名はコマンドラインの引数としても使われます。任意のターミナルウィンドウで “odv [ファイル名[.拡張子] ]”と入力してODVを起動してください。ファイル名には、絶対パス名またはODVを起動したディレクトリからの相対パス名を使用してください。相対パス名を使う場合は “.”と “..”はファイル名には使えません。以下の目的のためにコマンドライン引数を使用できます:
1. ODVを起動して既存のコレクションを開く: ファイル名にはコレクション名を使用して下さい。拡張子を省略すると、初期設定の.varが使われます。
2. 新しいコレクションを作成しデータを読み込む: ファイル名には読み込まれるデータファイル名を使用してください(ODVで読み込める形式、例えば.o4x, .txt, .csv, .josでなければなりません)。この場合は必ず拡張子を付けてください。ODVは、読み込みファイルのディレクトリに新しいコレクションを作成し、ファイルからデータを読み込みます。コレクション変数はデータファイル中の情報で決まります。
16.3
ODVコマンドファイル(バッチモード) (ODV Command Files (Batch Mode))

コレクションのオープン、指定した設定ファイルの読み込み、グラフィクスまたはデータ出力ファイルの作成のように良く使うコマンドをODVコマンドファイルに保存できます。ODVコマンドファイルは File>Execute Command Fileオプション、または “-x cmd_file”コマンドライン・オプションを使っていつでも実行できます。ODVコマンドファイルの初期設定の拡張子は.cmdです。初期設定でのファイルの場所はユーザーのホームディレクトリ下のodv_local/cmd_filesディレクトリです。このディレクトリが未だ存在していなければcmd_filesディレクトリを作成して、コマンドファイルをこのディレクトリに置いてください。

以下のコマンドがODVコマンドファイルで現在サポートされています:

open_collection
collection

collectionコレクションを開く(collectionには絶対パス名を使用)

open_netcdf

netCDF file, nce file


nce fileファイルからエミュレーションを使ってnetCDFファイルを開く(絶対パス名を使用)

load_cfg

cfg file
設定ファイルcfg fileを読み込む(絶対パス名または現在のコレクションのディレクトリからの相対パスを使用)

set_annotation_style
ptSize, textColor, bckgrdColor, frameColor, frameWidth
create_annotationに続いてテキスト注釈のスタイルを設定します。ptSizeはフォントサイズをポイントで、textColorはテキストの色を、bckgrdColorはテキストボックスの背景色を、frameColorはテキストボックスのフレームの色を、frameWidthはテキストボックスを取り巻くフレームの幅を設定します。全ての色は現在のカラーパレットの中から指定できます。bckgrdColorおよび／またはframeColorで-1を指定すると、背景ボックスまたはフレームは描かれません。全てのset_annotation_styleの引数は整数です。既定値は16, 0, -1, -1, 0, すなわち背景ボックスとフレームのない16ポイントの黒色テキストです。

create_annotation
iw, x, y, orientation, textAlign, “text”
注釈文textを、ウィンドウiwの正のx軸から半時計回りに角度orientationの方向へ(ウィンドウiw座標における)x, yの場所に作成します。textAlignは(x, y)における相対的なテキストの位置を定義します: center_center 0, cnter_top 1, center_bottom 2, right_top 3, right_bottom 4, left_top 5, left_bottom 6, right_center 7, left_center 8, left_center 8. iwとtextAlignは整数で、x, y, orientationは実数です。注釈文は “”文字で囲われている必要があります。

export_data
data file
generic ODVスプレッドシート・フォーマットを使用してdata fileに現在有効な測点のデータを書き出します。

export_graphics
iw, graphics file, dpi

解像度dpi (dots-per-inch)でgraphics fileにウィンドウiwのグラフィクスを保存します。graphics fileの拡張子.eps, .png, .jpgはそれぞれPostScript, PNG, JPEGを指します。引数dpiはPostScriptに対しては使えませんが、それでもdpi値は与えられなければなりません。

quit


ODVの終了。

注: 上記の全てのファイル名には、プラットフォーム(訳注: コンピュータの種類)にかかわらず、ディレクトリを区分する文字には “/”を使用します。複数の引数はカンマ “,”で区切られていなければなりません。ODVコマンドファイルの各行の長さは255文字を越えられません。最初の文字が “#”の行はコメントとして扱われ実行はされません。

16.4
パッチの定義 (Defining Patches)

現在画面に表示されている任意のデータプロットのX/Y空間に多角形を指定して、水塊のパッチを定義することができます。そのためには、定義を使いたいデータプロット上(例えばポテンシャル水温／塩分プロット)にマウスを動かして右ボタンをクリックしてください。ポップアップメニューからDefine Patchを選択して(カーソルが細い十字記号に変わります)、パッチを当てる多角形の節点上でマウスの左ボタンをクリックして定義してください(節点を削除するにはその近くにマウスを動かして右ボタンをクリックしてください)。多角形の定義を終了するにはEnterを押すか、マウスの左ボタンをダブルクリックします。多角形はODVが自動的に閉じます。それからODVはパッチの名前(拡張子なし)を入力するように促して、コレクション・ディレクトリ内のファイルにパッチの定義を書き出します。

一度コレクションに対して一つ以上の水塊パッチを定義すれば、導変数Patchesを作成して動作させるのにその定義を使用できます。背景ポップアップメニューからDerived Variablesを選択し、ChoicesリストからPatchesを選んでください。利用可能な水塊パッチ(上述に従って定義済み)を一つ以上選んでパッチ変数を作ることができます。 OKを押すと実行されます。あるサンプルに関するパッチ変数を評価するには、サンプルがパッチ多角形の一つの内部にあるかどうかを測って、(もし見つかれば)パッチの値としてそれぞれのパッチの数を割り当てます。サンプルが選ばれた全てのパッチの外側であれば、その値は欠測値としてセットされます。

その他の全ての変数(基本変数または導変数)のように、任意のデータプロットにおける任意の軸にパッチ変数を使用できます。例えば、指定した水塊の空間的な拡がりを表示するために、断面図に沿ったZ変数、または等値面変数として使用してください。
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16.5
変更の評価 (Custom Estimation)

VGグリッド化表示を使ったデータプロットにおいて、各々のデータプロット・ポップアップメニューのExtras>Custom Estimationオプションで選ぶと、ユーザーが指定した任意のX-Y点におけるZ変数の変更を評価することができます。ODVは、評価したい点のX-Y座標ファイルのファイル(以降では入力ファイルと呼ぶ)の入力を促します。このファイルはCustom Estimationオプションを呼び出すより前に用意されていなければなりません。このファイルは一行につき一組のX-Yを持ったプレーンのアスキーファイルで、X, Yの値は一つ以上の空白で区切られていなければなりません。点の数は無制限です。入力ファイルの各点に対して、ODVはZ値を計算(評価)し、入力ファイルと同じディレクトリの出力ファイルに、各々のXおよびY座標とともに評価値を出力します。出力ファイル名は入力ファイル名から導かれて “.est”が付加されます。

16.6
データ編集 (Editing Data)

現在の測点のヘッダー情報とデータ値を編集してから、ディスク上のコレクション・データファイルに修正値を保存できます。

ヘッダー情報 (Header information)
	現在の測点の測点ヘッダー情報を修正するには、ODVテキストウィンドウ上にマウスを動かして右ボタンをクリックし、Edit Headerを選択して下さい。そして、現れたダイアログ・ボックスで変更し、OKを押してコレクションファイルに変更を保存します。修正を破棄してコレクションファイルを変更しない場合はCancelを押して下さい。


	
[image: image38.wmf] 




測点データ (Station data)
ある変数に関する測点データを修正するには、ODVテキストウィンドウのその変数の上にマウスを移動させます。そしてマウスの右ボタンをクリックしてEdit Dataを選んでください(マウスがその変数の上にあるときに eキーを押してもできます)。ODVはダイアログ・ボックスを表示するので、(1)現在のサンプル(初期設定)、(2)ユーザー定義のサンプルのサブセット、または(3)プロファイル全体に関するデータ値と品質フラグを変更してください。Windowsの拡張選択キーであるCtrlまたはShiftキーを押しながらマウスの左ボタンをクッリクして、Sample(s)リスト・ボックス内のサンプルのサブセットを定義できます。プロファイル全体を選択するにはScopeグループにあるWhole Profileをクリックして下さい。
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単独のサンプルを選択すると、それに対応するデータ値がEditグループに表示されます。Valueフィールドに新しい数値を入力して、この値を変更できます(二つ以上のサンプルを選択した場合は、このフィールドは作動しません)。Delete Value(s)を押すと、選択された全サンプルのデータ値が削除されます。オリジナルのデータ値が永久に失われてしまうので、このボタンの使用には最大限の注意を払ってください。通常は、実際のデータ値は変更せずに、対応するQuality Flag項目をチェックして、選んだサンプルのデータ品質フラグを更新する方が望ましいでしょう。OKを押すとディスクに変更を保存し、Cancelを押すと編集作業を中止して、測点データをオリジナルのフォームのまま残します。
品質フラッグを変更すると、ODVのデータ解析から不良または疑わしいデータを除外するために別のサンプル選択基準が後で使えます。編集操作はコレクションの .logファイルに記録されます。 “.log”ファイルはUtilities>View log Fileオプションを使って閲覧できます。
16.7
カラーパレットの変更 (Changing the Color Palette)

データプロット・ポップアップメニューのDisplay Optionsを使ってPalleteコンボボックスにある利用可能なパレットファイルの一つを選び、ODVが散布図、断面図、等値面図で使われるカラーパレットを変更できます。ODVはその新しいパレットを使ってデータ・ウィンドウを再描画します。Highまたはtrueカラー・システムではデータ・ウィンドウ毎に別々のパレットを使用できますが、256色だけのシステムでは、全てのデータ・ウィンドウが(最後に選択されたものと)同じパレットを使用します。ODVバイナリ・ディレクトリ(通常はc:\Program Files\Ocean Data View (mp)\Bin)にあるPalEdt.exe プログラムを用いて新しいカラーパレットの作成または既存パレットの修正ができます。PalEdt.exeはUtilities>Invoke Palette Editorを選ぶとODVから呼び出せます。
ODVスタイルのカラーパレットでは177色が定義されています:
· 0-15:
基本色(ODV STATIONモードで使用); 8番目のカラーは断面図の地形で使用;
· 16-31:
グレースケール; 31番目のカラーはODVプロット・ウィンドウの背景色として使用;
· 32-144:
カラー濃淡に使用されるメイン・パレット;
· 145-160:
地図の海底地形と等深線に使用されるカラー;
· 161-176
地図の陸上地形に使用されるカラー;
16.8
一般的な設定 (General Settings)

ODVが使うグラフィクスやテキスト・フォントといった一般的なODVの設定、あるいは「良好なデータ・カバレッジのための基準(good coverage criteria)」は、メインメニューのConfigurationからGeneral Settingsオプションを使ってカスタマイズできます。
フォント (Font):
一つのあるいは様々なフォントのプロパティを選択し、グローバル・フォント・スケーリング係数fを設定してください。グラフィクスのテキストや軸の注釈を大きくしたければfの値を増加させ、小さくしたければ減少させてください。風変わりなフォントはODVのPostScript出力では対応していません。
“Text Windows>Font Size”はODVのテキストウィンドウ、ダイアログ・ボックス、ポップアップ・ウィンドウで使われるフォントサイズを決定します。

キャンバス (Canvas):
ODVグラフィクス・キャンバス、例えば地図とデータプロットが描画される白い領域の幅と高さを調整します。最大化されたODVウィンドウについて、現在のキャンバスの右または右下にグレー領域があれば、グラフィクス・キャンバスを拡げ、キャンバスのXおよび／または、Y軸にスクロールバーがあれば、グラフィクス・キャンバスを縮めてください。サイズの変更を有効にするにはODVを終了して再起動させてください。
印刷 (print):
“Show Collection Info”ボックスをチェックすると、ODVのタイム・スタンプやコレクション/設定情報がプリントアウトされます。
良好なカバレッジの基準 (Good Coverage Criteria):
例えば標準層への内挿や様々な導変数の計算といった一部のODVの操作では、有効な入力データが「十分に」存在している必要があります。例えば、力学的高度には水温と塩分が必要なので、各プロファイルが大きな穴が空いていてはいけません。Good Coverage Criteriaダイアログ・ボックスを使って、試験基準の設定と修正ができます。これらの基準は、特定の操作で必須のあらゆる変数に適用されます。一つ以上の必須の変数が試験に失敗すると、各々の作業は実行されません。
# Levels
必須の変数(A)に関する観測層の最小数;
Fraction >
少なくともxx %の層がAのデータに含まれている必要がある;
delta_Depth..
データ点の間の水深に依存する許容できる相違の指定。
プログラムの置場所 (Program Locations):
Webブラウザ(ODVヘルプで必要)とテキスト・ビューア(テキストファイルの閲覧に必要)を完全なパス名で入力して下さい。
16.9
ディレクトリ構造 (Directory Structure)

初期設定のODVのインストール・ディレクトリは、Windowsではc:\Program Files\Ocean Data View (mp)、UNIXでは/usr/local/odvmpです(以降、<odv_root>と表記; UNIXでは “\”を “/”に置き換えてください)。これは、特定の種類のファイルを含むいくつかのサブディレクトリのための基準ディレクトリです。マクロやパレットファイル、またはサンプル・データ・コレクションのように、ユーザーによって修正されるインストールファイルはユーザーのホームディレクトリ(< home >で表記)の下のサブディレクトリodv_localにインストールされます。
<odv_root>\bin_w32
Windowsの場合、
<odv_root>\bin_linux-i386
Linux i386の場合

<odv_root>\bin_solaris-sparc
SUN Solaris Sparcの場合、

<odv_root>\bin_irix6.5_mips
SGI Irixの場合、

<odv_root>\bin_aix-powerpc
IBM AIX powerpcの場合、
<odv_root>\bin_macx
Mac OS X の場合:
ODV実行ファイル、ヘルプファイル、PostScriptプリアンブル(preamble)ファイル
<odv_root>\coast\GlobLR:

低解像度の全球海岸線・海底地形ファイル
<odv_root>\coast\GlobHR:

高解像度の全球海岸線・海底地形ファイル(オプションパッケージで利用可能)
<odv_root>\doc:

ODV htm ヘルプファイル( pdf バージョンはODV webページから入手可能)

<odv_root>\include:

ODV includeファイルの初期設定ディレクトリ (例えば、オプションパッケージで利用可能なETOPO全球地形ファイルなど)。あるタイプの他のファイルを含むいくつかのサブディレクトが存在しています。
<odv_root>\include\atmhist:

様々な大気トレーサーガスの濃度の変遷。
<odv_root>\include\gazetteers:
ODV地形索引データベースファイル。
<odv_root>\samples:
ODVサンプルファイルのディレクトリ。データの読み取りやマクロ・ファイルのテンプレートに使用して下さい。
<home>\odv_local\data:
ODVデータコレクションの初期設定の基本ディレクトリ。データコレクションはディスクやCD-ROMのどこにでも置くことができますが、管理するコレクション毎のサブディレクトリの作成を推奨します。
<home>\odv_local\data\SAVE:

South Atlantic Ventilation Experimentのデータが含まれているDVサンプルデータコレクション。
<home>\odv_local\include\macros:

ODVマクロファイル(.mac).
<home>\odv_local\include\palettes:
ODVパレットファイル(.pal).
User’s default Temp directory:
一時ファイルのためのディレクトリ。ODVから始まって三日前より古いファイルをこのディレクトリから定期的に削除します。
16.10
ハードウェアの必要条件 (Hardware Requirements)

ODVマルチプラットフォーム版は、Windows(9x/Me/NT/2000/XP)、Linux、各種UNIX、Mac OS Xの各オペレーティングシステム上で動作します。ODVのハードコピー機能は、白黒とカラーのApple LaserWriter、キヤノン・レーザープリンター、HP DeskJetプリンターでテストされていますが、他のプリンターでも同様に機能するでしょう。PostScriptプリンターがあれば、Print の代わりにSave As PostScriptオプションを使うと、より高速で高品質な出力が得られます。高解像度の.pngまたは.jpgファイルに画面のグラフィクスを書き出すことも検討して下さい。一部のシステムではODV(mp)のインストールに管理者権限が必要になります。

16.11
制約 (Limitations)

	コレクションあたりの測点数
	制限なし

	測点あたりのデータ数
	100,000

	測点あたりの観測層数
	20,000

	データプロット・ウィンドウの数
	20

	コレクションに保存できる変数の数
	50

	ウィンドウあたりの等値線の本数
	50

	コレクション名の長さ(文字数)
	30

	変数名の長さ(文字数)
	60

	航海ラベルの長さ(文字数)
	20

	測点ラベルの長さ(文字数)
	20


17
ヒントとコツ (Tips and Tricks)

17.1
XYZ アスキーファイルのデータの可視化(Visualizing data from XYZ ASCII files)

あるXY座標におけるいくつかの数量Zの不規則な間隔またはグリッドのデータが、X,Y,Z値の三項目を含むアスキーファイルで非常に頻繁に提供されています。例えばXが経度でYが緯度の地図、Xが断面に沿った座標軸でYが水深の鉛直断面、Xが地理座標でYが時間の時間発展図などです。

これらの全ての場合で、ODVにXYZファイルを読み込ませ、ODVの全機能を使用してZ変数を表示させることができます。以下に述べる手順は、複数のZ変数を含むアスキーファイル、例えばカラムが三つより多いファイルに対しても適用できます。

ここではXYZファイルが地図を表す場合の処理方法を示します:

1. 水深(Depth [m])とZ変数(Z変数を説明するラベルと適切な単位)の二つの変数を持つ新規コレクションを作成します(出力先のディレクトリおよびコレクション名を選びます)。

2. Import>ODV Spreadsheetを選択し、XYZファイルを選んで読み込みます(XYZファイルの拡張子が.txtでない場合は、ファイルタイプでAll Filesを選ぶ必要があります)。

3. Spreadsheet File Propertiesダイアログで、(1)カラムの分離文字(ヘッダー行の項目はColumn Labelsリスト内の別の行に現れます)、(2)XYZラベルを含む行番号 (ラベルがない場合は1になります)、(3)最初のデータ行の行番号を指定します。
4. Header Variable Associationダイアログで、X変数と経度(Lon(°E))、Y変数と緯度(Lat (°N))を関連付けます
5. Import Optionダイアログで、Z変数(ソース)と二番目のコレクション変数(ターゲット)を関連付けます。それから一番目のコレクション変数(ターゲット)をクリックして、Use Defaultをクリックして初期設定の水深値を指定します(不明な場合は0を使用)。

ODVはXYZファイルからデータを読み込むので、通常の方法でデータを操作できます。Z変数の地図を一ページで作成するためには、Configuration>Use Template>SURFACE 1 Winの順に選択してください。必要ならば、いつものように表示オプションを修正して下さい。
17.2
成分分布と他の成分の等値線との重ね合わせ (Overlaying a property distribution with contour-lines of another property)

ODVは、(カラー濃淡および／または等値線による)一成分の分布図に、別の成分の等値線を重ね合わせた断面図または等値面図を作成することができます。このテクニックが役立つのは、例えば、任意の成分断面上の等密度線や、等値面または等密度面上の等深線です。
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そのようなプロットを作成するには、以下の手順に従って下さい：
· SECTIONまたはSURFACEモードでは、背景ポップアップメニューからWindows Layoutを選択してウィンドウ・レイアウト・モードに切り替えます。
· 下に置く分布のウィンドウを設定します(ウィンドウa: サイズと位置を定義; そのウィンドウのZ変数を選択(成分A))。
· ウィンドウa 上にマウスを動かして右ボタンをクリックし、Create Overlay Windowを選んでウィンドウa の重ね合わせウィンドウを作ります。重ね合わせウィンドウb (成分B)にZ変数を選んでください。Window Layoutコンテキスト・メニューからAcceptを選んでWindow Layoutモードを抜けてください。

· ODVがデータプロットを再描画した後に、ウィンドウb上にマウスを動かして、マウスの右ボタンをクリックしてDisplay Optionsを選びます。VG Griddingボタンがチェックされていることを確認して、背景色にnoneを選んで(自動でセットされています)、それからPropertiesボタンをクリックしてください。Do Color Shading項目のチェックをはずして、等値線の定義に進んでください。成分Aのカラー分布上でもはっきり見えるような
等値線の色(例えば白黒)を使用してください。OKを押すと表示オプション設定が確定します。

· ODVはデータウィンドウaとbを再描画し、成分Bの等値線はAの分布上に現れます。印刷またはPostScript, PNG, JPEGへ出力する前に、それぞれの注釈をドラッグして成分AとBのラベルを分けてください(ラベル上にマウスを動かして、マウス左ボタンを押しながら移動させます; この分離は再描画した後で繰り返されなければなりません)。あるいは、軸ラベルの自動生成を無効にして(Display OptionsダイアログでAutomatic Axis Labelsボックスのチェックをはずして)、注釈の追加で軸ラベルを作成してください。

· 要望が満たされたら、後で利用できるように設定を保存してください(Configuration>Save Configuration As)。

別のウィンドウが完全に重なる(ウィンドウaのような)ウィンドウにアクセスしてそのプロパティを修正する唯一の方法は、メインメニューからConfiguration>Window Propertiesオプションを順に選ぶことだけです。
17.3
コレクションでの中立密度の事前計算と保存 (Pre-computing and Storing Neutral Density Values in Collections)

簡単に素早く、その場(on-the-fly)で計算できる大部分の導変数(例えば、ポテンシャル水温、ポテンシャル密度、Brunt-Väisälä Frequency(ブラント─バイサラ周波数)など)と比較して、中立密度の計算はコンピュータに関わるコストが高く、多くの時間が費やされます。少ないデータのコレクションの解析や数の少ない測点をプロットするだけなら問題はありませんが、多くのコレクションや長い断面に沿った中立密度をその場で計算する場合は遅くて能率が上がりません。もし定期的に大きなデータセットで作業して中立密度が必要なら、新しいコレクションに中立密度を計算して保存しておき、後でこの事前に計算した値を使うことを検討すべきでしょう。しかしながら、新しいコレクションに保存された中立密度の値は、コレクションの中で対応する水深、水温、および／または塩分の値を変えてしまうと(例えば、データの編集や較正の後は)合わなくなってしまいます。そのような場合は、自らの責任において中立密度を再計算して保存してください。ここでは、既存のデータコレクションの全てまたは一部の測点に関する中立密度を持った新しいコレクションの作成方法を示します。

1. 既存のコレクションを開いて、中立密度を持つ新しいコレクションに含まれる測点を選んでください。コレクションの全てを処理したい場合は、全球地図をつくって、選択した測点の数がコレクション中の測点数と一致するか確認してください。

2. 背景ポップアップメニューのDerived Variablesオプションを使って、導数量としてNeutral Densityを定義してください。

3. Export>ODV Spreadsheetを選択して、ODVスプレッドシート・ファイルに中立密度を含んだ測点を読み込んでください。新しいデータセットの名前(以降ではxxx.txtと表記)を指定して、 Select Variables for Outputリスト内でNeutral Densityの出力が選ばれているか確認してください。

4. 新しいコレクションを作るために、xxx.txtファイルをODVデスクトップ・アイコンにドラッグ&ドロップするか(Windowsおよびいくつかのプラットフォーム)、端末ウィンドウから “odvmp xxx.txt”としてODVを起動させてください(Unix, Linux, Mac OS X)。新しく作成されたコレクションxxxは、ディスク・ファイルに保存された基本変数の一つとしてNeutral Densityを持っています。

17.4
出版物やウェブページでのODVグラフィクスの使用 (Using ODV Graphics in Publications and on Web Pages)

ODVの全ページまたは個々のデータプロットのような、どのODVグラフィクスも印刷文書、ポスター、ウェブページに含めることができます。

ウェブページ向けに、全ODV画面または個々のデータプロットのPNGもしくはJPGファイルを作成できます(背景領域上もしくは個々のプロット・ウィンドウ上にマウスがあるときにCtrl-s (Ctrlキーを押しながらs)を押して、出力形式としてPNGまたはJPGを選択してください。グラフィクス・ファイルの解像度を設定できます(初期設定は画面の解像度です)。そしてPNGまたはJPGグラフィクス・ファイルをウェブページまたは文書に使用してください。

印刷文書向けには、高解像度のPNGファイルを作成するか、ODV PostScript(.eps)出力を代わりに使用してください。
タイプセットやページデザインの様々なソフトウェアは、テキスト／グラフィクスが混在するページへのEncapsulated PostScriptファイル(.eps; カプセル化されたポストスクリプト・ファイル)の挿入をサポートしています(例えばMS Wordとその互換ソフト、LaTeX、Adobe PageMakerなど)。LaTeXを使う場合は、TeX文書にPostScriptグラフィクスを取り込む方法の実例であるPssample.tex (通常はc:\Program Files\Ocean Data View (mp)\Samplesにあります)を参照してください。必要なepsfおよびepsfigスタイル・ファイルもサンプル・ディレクトリに含まれています(訳注: ODV (mp) Version 1.3aでは$ODVMPHOME\samples\SampleFiles.zipの中に収録されています)。
WordやPageMaker、その他の出版ソフトウェアを使用する場合は、次のガイドラインに従って下さい: いつも通りにページを作成して、正しい位置にODV PostScriptファイルをそれぞれ挿入して下さい。適切に図のサイズを調整します。ページの作成が終了したら、文書をPostScriptプリンターで直接印刷できます。PostScriptプリンターが利用できない場合は、PostScriptプリンター・ドライバーとGhostScript/GhostViewパッケージ(http://www.cs.wisc.edu/~ghost/)をコンピュータにインストールする必要があります。その場合は、プリンターにPostScriptプリンター・ドライバーを選んで、ファイルに出力してください。GhostViewでこのファイルを開き、システムに接続しているプリンターで印刷して下さい。

17.5
航跡図の作成 (Making Cruise Maps)

ODVのMAP モードを使って、与えられたデータコレクション(全てまたは一部の測点)の高品質な測点図を作成できます。しかしながら、実在する測点データにアクセスすることなく、または測点データへの興味がない場合でも、船上で、あるいは次の航海の航跡図を作成したいときがあるでしょう。ここではその処理方法を述べます:

· ディスク上の空のディレクトリに、航跡の地理情報を含むアスキーファイルを作成してください。このファイルは記述的な名前(例えば、CruiseTrack_xxx.txt, ここでxxxは航海名を表します)で、generic ODVスプレッドシート・フォーマットの仕様を完全に満たしていなければなりません。

ファイルの一行目は、次のヘッダー行を使ってください(カラムはタブで区切られています):

Cruise  Station  Type  mon/day/yr  hh:mm  Lon (°E)  Lat (°N)  Bot. Depth [m]  Depth [m]  Dummy [ ]

ヘッダーラインの直後に、各測点または航跡の節点につき一つのデータ行を追加して、各々の測点または節点の適切な情報を与えます:

	Cruise
	航海名

	Station
	実在する測点ラベルまたは連続番号

	Type
	“B”

	mon/day/yr
	実在する測点または現在の日付

	hh:mm
	実在する測点の時刻または “00:00”

	Lon (°E)
	十進数での測点の経度

	Lat (°N)
	十進数での測点の緯度

	Bot. Depth [m]
	実在する測点の現場水深または “0”

	Depth [m]
	“0”

	Dummy [ ]
	“0”


· Windowsシステムでは、ODVデスクトップ・アイコン上に用意した航跡ファイルをドラッグ&ドロップしてください; その他の全てのプラットフォームでは端末ウィンドウを開いて、航跡ファイルのあるディレクトリに移動し、コマンドラインの引数で航跡ファイル名を指定して(例えば “odvmp CruiseTrack_xxx.txt”)端末ウィンドウからODVを起動してください。

· ODVでMAPモードに切り替えて、興味のある領域を定義するために地図を拡大してください。 地図の Display Optionsを使って、測点のドットのサイズと色を指定し、注釈のスタイルを定義します。ダブルクリックして指定した測点を強調し注釈をつけるか、地図ポップアップメニューから Extras>Add Graphics Objects>Symbol Setsの順に選択して、強調および／または測点間を結合させてください。

· 必要に応じて航跡ファイルの最後に新しい測点を追加して、ODV (mp)デスクトップ・アイコン上に更新した航跡ファイルをドラッグ&ドロップするか(Windows)、あるいはコマンドラインの引数で航跡ファイル名を指定してODVを起動してください(他の全てのプラットフォーム)。

17.6
海岸線と等深線ファイルの準備 (Preparing Coastline and Bathymetry File) 

ODVには、粗い解像度の全球の海岸線と等深線ファイル(GlobLR)が付属しています。高解像度の海岸線と等深線データは、全球ファイル(GlobHR)または一部の海域(Baltic, BayOfBiscay, MedHR, MeditHR)がオプションパッケージとして利用可能です。ODVが提供していない海域を高解像度な海岸線と等深線で表現したいときや、そのような利用可能な高解像度のデータを持っているときは、ODVで使用するファイルを作成する方法を以下に紹介します。
新規ファイルの準備 (Preparing New Files)
海岸線と等深線データは別々のファイルでなければなりません。海岸線ファイルの名前として “World”を推奨します。等深線ファイルの名前は “xxxm”という名付け方に従わなければなりません。ここでxxxは各等深線の水深を示します(水深値と “m”の間に空白は入れません)。海岸線／等深線ファイルのアスキー版の拡張子は.coaでなければなりません。

海岸線(または等深線)ファイルの緯度経度座標は、それぞれ1500未満の頂点から成る個々の多角形のセグメントに保存されます。緯度経度は十進数で、東経(0～360)、北緯(-90～90)の度単位です。“.coa”ファイルにおける多角形のセグメントのフォーマットは次の通りです：
nT nS

lat_1 lon_1

.....

lat_nT lon_nT

ここでnTはこのセグメントの頂点の総数を、nSは「本当の」海岸線／等深線の頂点の数を示しています。 “nT”が “nS”より大きい場合、頂点nS+1 .... nTはセグメントを閉じるのに使用されます(陸側の閉鎖)。これらの余分の頂点はセグメントが描画されるときには表示されません。nT, nSともに1500未満でなければなりません(ヒント: 長い等値線をいくつかに切り分ける場合は、それぞれ1000未満の頂点数としてください。これによって複雑なセグメントを閉じるための場所を残します)。セグメントの最後の頂点に続く行では、次の多角形のセグメント数nT, nSまたはファイルの最後を示す“0 0”となります。

ファイルがODVで使用される前に、データをバイナリ形式(.cdtファイル)に変換しなければなりません。これはODVを使って直接実行できませんので、この作業を完了するにはrschlitzer@awi-bremerhaven.de宛に.coaファイルを(zip圧縮にして)送付してください。
等深線と海岸線を塗り潰すには、塗り潰す領域が陸側の領域を表すように、全ての多角形が正確に閉じていなければなりません。等深線や海岸線の輪郭だけならODVで使用できますが、線描画モードを選んで塗り潰しを無効にしなければなりません(地図のDisplay Optionを使って表示設定を変更してください)。

新規ファイルのインストール(Installing New Files)
海岸線、等深線、地形、重ね合わせファイルのバイナリ版をインストールするときには、次の手順にしたがってください:
· ODV  “coast”ディレクトリ(通常はc:\Program Files\Ocean Data View (mp)\Coast)に新しいサブディレクトリを作成して、それを説明する名前を選択してください(例えばGulfOfMaine; このディレクトリは新しいシリーズのファイルの基本ディレクトリです)。この新しいサブディレクトリに、“Bathymetry”, “Topography”, “overlays”ディレクトリを作成します。
· 海岸線ファイル(通常“World.cdt”)をシリーズの基本ディレクトリにコピーしてください(例えばc:\Program Files\Ocean Data View (mp)\Coast\ GulfOfMaine)。
· 全ての等深線ファイル(例えば100m.cdt, 500m.cdtなど)を “Bathymetry”サブディレクトリに、全ての地形ファイルを “topography”ディレクトリに、全ての多目的な重ね合わせファイル(川、湖沼、境界など)は “overlays”ディレクトリにコピーしてください。地形および／または重ね合わせファイルがなければ各フォルダは空のままにしておきます。
新規ファイルの使用(Using New Files)
ODVの地図で新規にインストールしたファイルを使用するには、以下の方法に従ってください:

· 地図の “Display Options”ダイアログ・ボックスを呼び出します(例えば、地図上でマウスの右ボタンをクリックして “Display Options”を選択します)。
· “Layers”タブを選択します。
· “Series”コンボボックスで、新しくインストールしたシリーズの名前(例えばGulfOfMaine)を選択します。
· レイヤーセットを選んで(例えばOcean Bathymetry)興味のあるレイヤーセットを構成して、 “Compose”を押してください。 “Available”リストから使用したい等値線ファイルを選択して、希望する描き方や塗り潰し方法を設定し、最後に “<-“を押して “Selected”リストにファイルを追加します(注: “<-”を押し忘れるとファイルは追加されません)。“Selected”リストからファイルを取り除くには “->”を押してください。
描画特性の指定は、次の規則に従ってください:
(a) 地形の輪郭を線で絵が描く場合は適切な線の幅、種類、色を選択して、輪郭が不要ならカラーを “none”にしてください。Windowsの制約によって、1ピクセルより広い線は、画面やPNG, JPGファイルでは常に一様となりますが、ODV PostScriptファイルであれば、いかなる線の幅の選択でも受け入れられます。
(b) 地形を塗り潰す場合は適切な塗り潰し色を選択して、塗り潰しが不要な場合は “none”を選んで下さい。

線と塗り潰し色に “automatic”を選択すると、ODVは初期設定の色を使用します。一部のレイヤーでは “automatic”の初期設定が “none”になっています。また、河川や境界のような一部の地形ファイルは塗り潰せないので、塗り潰し色は明示的に “none”と設定しています。
ODVが地図を作成するとき、“Display Options”ダイアログ・ボックスに表示された順でレイヤーセットが処理されます。あるレイヤーセットでは、Selectedリストに表示された順に個々のレイヤーが描かれます(海底地形および陸上地形のレイヤーは、それらが追加されたときに自動的に並び替えられます)。海氷の分布は “pre-Coastlines”セットで、湖沼、河川、境界は “post-Topography”カテゴリーで定義してください。
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